30 March 2016
Small new features:  linescan floater - crosshair cursor option and navigation (of other TSG screens) to nearest sample clicked;  scratchpad send to all scratchpads (vswir and tir), not just the "compatible" one;  vlines - option to plot just the annotation (no line);  hole screen scalar dot plot - dots are now joined by a faint line.
31 March 2016
TSA update fix, for downloaded datasets that don't have a version number in their TSA "blocks".   (Their active mineral lists weren't getting updated.)
12 April 2016
First cut of jCLST.   Preliminary checks - it doesn't look entirely daft, but the TIR scalar calcs are still highly questionable.
19 April 2016
A bit more work on jCLST.
Modules:  There's a new one for reading an ENVI speclib or hyperspectral image into a "commpactlib" structure, along with the necessary few compactlib "handle" support calls.
27 April 2016
Modules:
There's a new module for reading a TSG speclib.   It just reads wavelength info, sample names and spectra into an in-memory structure.   It's a basic thing meant for a speclib of manageable size.   It's the companion to the ENVI reader that was added recently.
The auxmatch scalar-calculation method is in.   There is also a query support call that will enable one to get name+score in one pass (for example).   Next up is the CLS unmixing extension.
4 May 2016
Modules:  The CLS unmixing extension to auxmatch is in, and has survived some testing.   It fits into the normal scalar-calculation flow but has an extra query call to support the retrieval of unmixing results, adjustment of active auxlib samples (e.g., if a domain Restricted Mineral Set is handy), and various other things.   It is more evolved than the basic auxmatch-CLS in TSG.
26 May 2016
jCLST: Some attention to the scalar-calculation code.   I ran a couple of comparisons against Andy Green's drillhole results - not bad.   I think Andy is still working on scalar adjustments and I'll put them in once I have them.   More serious testing will follow.
Modules: TSA training is in (part of the general auxmatch method).   I've started on the unmixing support, which is more work than training.
3 June 2016
Modules:  The TSA unmixing core has now been added to the "auxmatch" scalar method.   It seems to be okay but I have only done basic testing of the SWIR option (the trickiest option).   It could use a lot more testing.   Also, I haven't yet extended the separate auxmatch reporting call to pull out a coherent TSA result.   I could move onto that and / or add the SWIR TSA+ extension to the core.
14 June 2016
jCLST:  I checked results with Andy over 7 drill-holes (selected by him).   We saw issues with Serpentine and Magnetite and maybe the SWIR TSAPlus FeOH scalar in one of the holes, but otherwise things looked quite good.   I know what to do about the Serpentine and Magnetite, and we'll check out that FeOH scalar more closely.
Modules:  I wrote a basic TSA reporter for the auto-selected result (the "main" TSA result in TSG until Plus came along), then proceeded to do some debugging.   The thing checks out okay for SWIR TSA.   As this is a fresh look in a sense, I have the flow able to deliver spectrum-, mineral-, subgroup- or group-level results.   I still have to do the "illitic" extension for the SWIR TSA.   I thought that a TSAPlus result selector might be next but had forgotten that Plus wants the TIR for carbonates.   Sometime later I might do a Plus+jCLST combo thing.
15 June 2016
jCLST:  The improved serpentine and magnetite handling is in.   Andy might still introduce a special magnetite rule - like his hematite rule but triggered by negative deltaT rather than SWIR identification.
Fix to TSAPlus' FeOH scalar.
23 June 2016
New "elite" aux-attach system (with floater TSA) now includes VNIR support.   The bundled floater TSA is hard-coded to use domain RMS as that's largely what this option is all about.
Tray-pic generation tool now has the option to do just a subset of pics according to a depth range.   Generous whole-tray granularity normally, but finer with two of the 'stick' options.
24 June 2016
New option under File -> Special:  Plaster out the 852nm laser bump.   (This bump is sometimes seen in HyLogger2/3 data.)
28 June 2016
Tray pic generation:  option to have pics / sticks done over a subset of the depth range:
Interactive depth logging:  spot final-mask editing;  new hot-keys.
8 July 2016
Fix to domained "user jCLST".
25 August 2016
Modules:  Plus extension for SWIR TSA is in and seems okay but could use more testing.   There's some JSON-format TSA result reporting.   The current SWIR TSA reflib is now "built into the code".   There's a java JNI interface.
2 September 2016
Modules: jCLST is coded.   The module suite includes setup and calc calls.   I intend to start debugging it next week.
12 September 2016
Modules: jCLST is looking okay.
6 October 2016
Scat: I enabled sorting on an RGBColour scalar.   (Hue*intensity is the main driver.)   I made colour sorting optional for the "hist2" type.   (It used to be hard-coded on.)
I refined the linescan loupe a bit.
I took out a deadlock situation from scalar-construction eval mode.   (Occasionally I hit a floater critical-section deadlock in debug mode.)
7 October 2016
Linescan adjustment tool:  Option added to mask excess width in black or white.   It works on the per-section active-width records.
11 October 2016
Stack screen:  Moving-average smoothing option.   This called for a fundamental change to the stack screen's data fetch and all bits (calc, plot, mouse handling etc) that use it.
13 October 2016
jCLST bugfix: The "mineral" scalars were off by 1 for the trash classes, e.g., reporting "not in library" in place of "aspectral".   The "group" scalars were wildly wrong (out-of-bounds values) for trash classes.   Colouring a scatterplot with such a group scalar could actually crash TSG.   The scat plot routine concerned also has a guard against this now (for old data).
18 October 2016
Bugfix:  Crash on floater arrow navigation when the Stack screen is current.
jCLST:  Last-stage application of user "allowed minerals" restriction, filtered by SWIR bias and TIR scalars.
SWK licence:  offline deactivation supported.
20 October 2016
jCLST:  for "user jCLST", the active-minerals list is applied just before the final fit, but without the "SWIR better" and jCLST-TIR-scalar overrides that I so carefully crafted in recently.   (In hindsight that turns out to be coherent.)   In other words, the list is applied as-is.
25 October 2016
Code check-in to try a proxy thing via Peter W's PC.
31 October 2016
More stuff with proxies for the SOLO licence server.
2 November 2016
Some more work on proxy bits;  some work on SOLO licence checking - tracking if a licence was first activated offline;  demanding that a check succeed after having failed (no connection) for too many days (variable depending on licence).
3 November 2016
More fiddling around with proxy stuff;  small fixes to hole screen layout copying.
4 November 2016
SDF colour cal import - no dynamic height adjustment in image stitching.
Scat screen set scope - tidied up set-virtual scalars, esp. when the set-scope scalar is changed.
9 November 2016
Fix - CLS scalar update - colours!
Mod - preferences - some changes (display related) are mirrored to the assoc dataset.
'nother round with the proxy discovery stuff
15 November 2016
New build of TSGDBFunctions libs and a basic error message length truncation to ensure we don't overrun buffers.
18 November 2016
More work on timed licence logic.
21 November 2016
Scat screen:  A left click on a colourbar block highlights the samples that correspond to the block (class or numeric colouring).
Rebuilt TSGDBFunctions for vs2010.
6 December 2016
Licensing:  More "detailing".   Affiliate info shown.
TSA/CLS:  New option (in Settings->TSA) to lock down individual TSA and CLS result sets.   Changes to the recalc-on-open logic and dialogs.   A few issues fixed in the MS6 -> MS8.2 TIR spectrum-level remapping.
8 December 2016
Dbase:
Changes to get the new TSA/CLS lockdown to work.   Default for old datasets (already in the database) is all TSA result sets are locked down by default on download.
Some work on cleaning up the special / unique scalar marking (tray section, depth scalars etc) in TSG on dataset open and during a dbase download.
15 December 2016
Some more minor fixing.
Also, I went through the online-manual files and sorted out the more obvious TSG7 references.   The manual contents are still largely as they were though - dated.
22 December 2016
TIR TSA - chlorites now on by default in the Active Minerals List (were off).
Minor fixes / adjustments.
Support for the setup executable hosted on SOLO server.
23 December 2016
Last check-in for 2005.   Sorry I mean 2016.   (Good grief what just happened there?)
Small fix to numbered-layout handling (I hope);  new CSIRO icon in About box.
17 January 2017
A few more changes.   Notable fix to CLS scalar construction page init where there's an attached aux lib.
This is THE first proper SOLO release of timed core.   Build 36.
14 February 2017
A number of little changes / fixes and doc additions.
External-lib TSA support is basically in - needs more work though.
Minor tweak to non-domained jCLST's magnetite & hematite handling;  serpentine now on by default in TIR.   (Serpentine handling is still hanging out on the outskirts of logic.)
Build 37.
15 February 2017
Fix to full-resolution CSV import - "Sample filename" dataset match item not shown for non-HyLogging datasets.
SWIR TSA - teflon is excluded by default.
tsgsysv.startpath - was getting zapped (by the new title that's longer than before).   Affected help file display.
21 February 2017
Added code signing to the relcore TSG executable build process and NSIS installer.
22 February 2017
Updated svn ignores.
Renamed tir_srss to tir_error in previous versions of TIR TSA (Dbase tables).
Added platformtools paramater to build on newer version of visual studio.  Added PNG environment variable for png library/headers. Removed unused build configurations.
Updated ignores.  Cleaned up solution file.
8 March 2017
Added domained TSA to scalar groups list and rebuilt .lz resource files.
15 March 2017
External libs:  TIR lib handling had been spoiled by a recent SWIR change.   TIR items were being consolidated to the mineral level.
Licensing:  We see problems on some Win10 PCs - TSG fails to start.   Task manager shows the TSG process running for a few seconds.   We don't see this on our own Win10/32 and Win10/64 test PCs.   I have coded support for a startup log to help find where things are failing.   It is activated by a /DEBUG command-line switch.   I have also wrapped certain calls (in the licence startup) with exception handlers.
Downsampler:  CLS class scalars were not getting exported with names.   The Downsampler judges certain things by scalar icons...   (fixed)
SWIR TSA lib:  We've started replacing proprietary spectra.
17 March 2017
SDF TIR import:  Error codes now come from a different control word.
Occasional SoftwareKey licensing issue on Win10:  The error seems to have gone, now that I have peppered the startup code with progress logs and exception catchers.   (No exceptions encountered BTW - the thing just works!)
20 March 2017
Build 38.
It used to be the case that if a licence was locked to a dongle then deactivation was forbidden.   You couldn't go back to a regular node lock.   I've taken this restriction away.   On consideration, there was no really solid reason for it.
TSG remembers the last good licence ID & password, and primes the activation dialog accordingly.   This should streamline things for people who move their licence a lot.
I fixed a few glitches and things.
28 March 2017
Build 39.
Importantly, a routine in the SoftwareKey ProtectionPlus5 library (called during TSG's licence setup) could throw an exception.   This has been fixed by SoftwareKey.   Build TSG with a recent PP5 lib.
Minor change to jCLST's handling of serpentine when the accompanying SWIR result is invalid:  The serp ID must come from lizardite, not antigorite, otherwise no serp.
Some other minor modifications.
31 March 2017
Small tweaks to the external-lib TSA calc.
Recently there was a small fix to the TIR-enabled SDF import (error flags) but there's more to come here once Phil's LabView prog is sorted out.
Some work on licensing docs.
The installer now picks up if it has been run with admin power and, if so, installs to program files instead of user's appdata\locsl.   Also, the actual installation dir should be picked up properly within TSG.
Fixed issue when downloading datasets with more than 10 image logs.
5 April 2017
Rebuilt TSGDBFunctions.
7 April 2017
The release version of TSGDBFunctions.lib was not in the svn trunk for some reason, so my builds weren't using the latest one!   Fixed by PW.
The Sillimanite spectra in the MS8.2 reflib were wrong (independent comparisons) and that issue has been addressed.
Floater TSA manual mixture-level selection was glitched for TSA Plus.
Licensing:  Auto download (from CSIRO ftp) and running of the latest TSG8 setup program is in.   Some messing around with the setup program (admin mode - but we probably won't keep the changes).
HyLogging SDF import: Fix to upcoming TIR-enabled chip-mode import.
Layout copying:  Some attention to spectral log columns (possible crash).
11 April 2017
Added Visual studio TSG installer.
21 April 2017
Small mod to scat hist plots - separate control for colourbar sorting.
Scat-screen class scope - glitch fixed in setting up the class-item list (wasn't done sometimes;  revealed by flicking through layouts)
Floater TSA from smoothed scat-screen spectra - debugged and working now.   (Restricted to a REFLECTANCE stack now.)   Also, the Y-axis label is in blue when the thing is driven by a smoothed spectrum.   What's more, a recent change to set up "domained" was causing TSG to crash quite often, and this has now been fixed.
Smoothed stack - fixed bug in data fetch when near the end of the dataset.
Edit scalar names & groups - screen is redone on close (renamed log-screen headers).
General - consolidated the general cleanup on dataset close.
Scat standard setup:  rounded Y range now off by default.
Floater scratchpad - an info dialog is now shown if the floater is about to purge its scratchpad, e.g., on dataset change.   (It just used to ask you to select a file, mysteriously.)
Floater CLS:  Set options: Used to be just "Copy to".   Now there are "add to" options as well.   Otherwise I'm working on this tool.   More to come soon.
Licensing:  Stuffed around with this a fair bit, trying to eliminate the little bit of free premium time that one *might* get with a base licence (for arcane tech reasons).
28 April 2017
Scalar-list glitch addressed.   Revealed when a set-scope hist2 scat sub with weight AND mineral virtuals plotted, is changed to global scope.   In the death, a scalar list is sent TDT_SETCURSEL and asked to display an item it doesn't have, so it sets to its first item - "switch dataset" - a list virtual that isn't a valid scalar.   I changed the list handling to keep what it had before.
9 May 2017
Licence - startup time reduced.   Timed licence checking is done just once a day.
Floater - fairly rare crashing bug fixed (related to colour component in plot title).
Depth logging - tidied up depths after end-of-tray marker.   Red highlight on current click-lock radio button.
Scalar list - tidied up the weird nothing-selected situation that can happen with a change to the scatter screen class-scope scalar.
11 May 2017
I put a class-scalar integrity check in the database-upload prelims.
I worked on dynamic dataset support a bit.
I fiddled with the new installer a bit.
17 May 2017
More work towards dynamic datasets.
Doc on setting up TSG8 QC.
19 May 2017
A little more tinkering with the setup program.   (Reverted to the original commit first.)
Excess "opened in read-only mode" dialog in QC after dataset creation - tidied.
Working on a licence startup crash in WINE (linux).   Not resolved yet.
24 May 2017
Floater GUI event handler:  Jon gets a crash that I can't repeat.   I think it's in this routine.   I've wrapped in an exception handler, with some tracking, to help locate it.
Floater wheel-mouse scroll support added;  linked to floater "previous" and "next" buttons.
Database:  Licence nanny glitch for the "headless viewer" NVCL download component.   Preventing scalar downloads.   Fixed.
Licence - proxy support:  The first proxy detection method was returning a "failed" result even when it worked (so the proxy wasn't getting hooked up).   Fixed.
Batch mode:  Passwords in a DB upload/download script are no longer echoed to the log file.
25 May 2017
Depth logging - tweak for when tray start/end marker depths are edited.
WINE (Unix) compatibility - some attempt to circumvent possible crash on startup.   A bit more work to try to make headless mode on WINE happy.
30 May 2017
Public release, build 8.0.2.2.
I think that the Visual Studio installer that we've been trying is too smart by half and am back to using the NSIS installer after adjusting the registry keys that I make it write.
7 June 2017
Settings - bugfix, spec resid controls (fiddling can crash) when no dataset is open.
TSA colours, UI issue - changing a TSA result-set's colour mapping only works if the result set is current.   Now I disable the menu concerned if the set isn't current.
NVCL download (unlicensed "headless"):  Batch-script parsing wasn't licensed.   A test in the cal-data download was probably too strict.
Chasing a headless db download issue.
9 June 2017
A bit more tidying up for use in the NVCL download service.
Bugfix - crash - stack screen when current sample is navigated via floater.   (Crash in "mousemove" routine.)
14 June 2017
Some work on the (external) SWIR TSA reference library.
Small adjustment to the ASD import, to handle Ian's files.
20 June 2017
Bugfix: TIR TSA standard algorithm numbers were not being set for newer (TSG8) TIR TSA/jCLST result sets.
Default database publishing: now on for all user / domained TSA / jCLST result sets.   (Wasn't on for un-domained user TIR.)
Some work on the dynamic import control panel.
29 June 2017
New functionality: dynamic ASD-binary spectral import for field datasets (that get expanded dynamically) and/or floater scratchpad.   Setup dialog included and everything.   Basic debugging - it appears to work.
30 June 2017
Added TSGDBCheckNewestDBAlgorithmOutput function to check if an NVCL database has a specific algorithm definition.  This can be used to automatically check if an algorithm definitions update is required.  Also, added some extra thermal spectra download log lines.
3 July 2017
TSG's Standard-algorithm handling on dbase download was incomplete!   (Different to previous issue.)
Dbase "update standard algorithm definitions" is now done automatically, if necessary, at the start of an upload.   (The check is done with a new dbfunctions function.)   Also, the dataset-version dbase comparison that TSG does when opening a dataset has been taken out.   It slowed things down and I think it wasn't that useful in general.
Spec-name glitch in dyna import fixed.
6 July 2017
I converted the ancient "common minerals" WinHelp file to HTML.   (CHM file.)   I hooked it up in TSG, using simple navigation.   (Each mineral has its own .htm file so simple navigation like this is possible.)   I haven't changed the ancient binary feature-table file yet.   A few of the names in there might need updating.
I reworked TSG's display of help files a bit.
7 July 2017
Tinkered with the dynamic-dataset stuff.   Generally changed the import's default interp. from linear to Lanczos.
Increased maximum tray picture download size to 20mb to match maximum upload size.
20 July 2017
Fixed an issue during database download caused by missing calibration data.
25 July 2017
I added the OreXpress .SED format to the dynamic import system.
26 July 2017
I added the generic ASCII format to the dynamic import system.
1 August 2017
Licensing crash fixed.   The SWK ProtectionPlus 5 load-license call could crash (totally, no exception) if given a path that contained non-standard (>127) ASCII characters.   Discovered through a problem report from a Chinese customer.   Turns out PP5 wants UTF8, and I think such "ASCII" characters can be illegal UTF8 encodings.
2 August 2017
On request I changed the default setting of scatterplot "rounded X range".   It was on by default.   Now its default is taken from the TSG-global "xnice" setting.
The TIR spectral residual range is now forcefully hard-coded to [-0.5, 0.5].   Previous attempts at this were half-hearted.   This one's brutal.
3 August 2017
Floater TSA mode is enabled for a QC licence (as it was in 7).
Bug in SDS and SDF import's "select by directory" fixed.
4 August 2017
Small change to scat sub axis-rounding default.
Doc on new dynamic import functionality.
Old graphics included in subversion check-in.
7 August 2017
I added a system-wide setting for the default plot format of a numeric log column.   (Following a request from Belinda Smith.)
16 August 2017
Dynamic import:  Fixes to the directory-watch mechanism.   Moving of files could fail (e.g., file already at destination) and cause a sticky situation.
Relative date scalar:  New method in the "Core" scalar sub-group.   Relative date is a proper number in TSG (unlike regular date) and should be good for plots.   I also updated the SDS and SDF imports to "spread" a tray's scan date across the tray's samples a bit, so that all the tray's samples aren't lumped with the same timestamp.
This new scalar method required a DATASET VERSION BUMP.
The blue TSG icon is back.   There's a discrete "8" at bottom left.   This is build 8-0-2-7.
17 August 2017
I fixed "save as" to work with dynamic datasets.   It trims off unused space, but wasn't adjusting domain bounds and wasn't writing an event.
23 August 2017
Fixed a floater TSA bug.   Floater system SWIR TSAPlus was coming out wrong.   The "illitic" class remapping was being done before the Plus stage and this spoiled Plus.   I moved it to after Plus.   I also took out various items from the floater TSA menu for when a System TSADB is selected, so that the user can't mess with system TSA floater stuff.
I also improved the mix level selection (floater menu) on TSA change.
24 August 2017
Domain editor:  Error in coloured sub-group list.   It was including TIR default selections even when the dataset had no TIR component, and there were issues when no domains had been defined (i.e., there was just a domain 0).   Fixed.
25 August 2017
SDS import:  It was possible for bad blackbody data to trigger an old correction we had for Vic data.   (Case in point: new problem data from Adelaide, ruined by this correction.)   This correction was done before the (optional) normal TIR calibration and couldn't be turned off.   Fixed.
Floater linescan:  Glitch fixed.   For very small datasets where there wasn't enough imagery to fill a portrait floater's height, the empty space was being left at the top.   This spoiled the current-sample marker.   Empty space is now left at the bottom.
29 August 2017
Scatter screen:  new "fit" overlay option for scatter and grid plots - moving average.   (Feature request.)
1 September 2017
Scatter screen moving-average overlay:  Changed to use (sorted) data X instead of moving-average X.   In other words it's just a Y moving average now.
Licence: Eased up on the nag for when the licence check can't reach the server.
Minor tweaks.
Build 8-0-2-8 goes out.
4 September 2017
ASCII import:  Modified to detect and extract RRUFF headers automatically.   (They start with ##)
Dynamic import:  Modified to support general wavelength units.   (There was some expectation of nanometres.)
Build 8-0-2-9.
8 September 2017
Starting on Andrew Rodger's DBSCAN-based clustering.   Coding a DBSCAN routine myself.   I tried implementing a recursed method that seemed okay until I ran it on a biggish dataset and the recursion level reached around 10000 and the stack couldn't handle it.   I have now coded a non-recursed method that seems okay.   I still want to tidy it up some.
12 September 2017
I have a DBSCAN clustering routine with a correlation-based cluster-combining post-processing pass.   I have a couple of weird options in there too.   I've been trying them out using a hard-coded test call.   I am about to start putting them into a proper place in TSG, e.g., a new scalar.
25 September 2017
New class-scalar method: FXClust.   (It appears to be a new method but is technically a new variant of the "featex" method.)   It's an implementation of Andrew Rodger's DBSCAN-based feature-extraction clustering procedure, with steps DBSCAN clustering, correlation-based cluster merging (opt), spatial smoothing (opt).   I have added a couple of experimental clustering inputs (opt, with weights):  one based on (feature1_depth - feature2_depth) and another based on sample index (for a spatial control).   The spatial smoothing pass has a simple sanity control based on spectral correlation.
I do not have evaluation-plot support yet.   I'd like to be able to show evaluation plots for each of the 3 stages.   Plots should include feat1 vs feat2 scatters coloured by cluster, virtual-section vs secsamp "rasters" coloured by cluster, and cluster class mean +- 1SD spectral plots.
6 October 2017
FXClust scalar: Evaluation plots are done.   There are 3 plot types and each can be done after clustering, merging or smoothing.   Plot 1 is a scatter of feat1 wvl by feat2 wvl, coloured by class.   Plot 2 is "spatial" with x=virtual section and y=secsamp;  coloured by class.   Plot 3 is of class mean spectra and is accompanied by a floater list.   Any number of class means can be selected for an overlay plot, and if just 1 is selected then it gets a laboriously-coloured standard-deviation envelope.
9 October 2017
FXClust: Spectral layer selection added for the calcs / eval plots based on spectral correlation.
11 October 2017
FXClust scalar:  Some tweaking.   Documentation.
17 October 2017
FXClust: I adjusted the depth input.   I added more controls for all of the evaluation plots:  scat / raster dot size;  scat x/y selection;  class correlation matrix (rendered in the control panel) to easily inspect class pairs.
19 October 2017
FXClust: TSG's TIR feature-extraction just wasn't making the grade here.   I have coded Andrew's TIR feature-extraction surrogate instead.   It works much better for TIR.   I am also experimenting with a substitute for Pearson's correlation in the correlation checks.
26 October 2017
Corescan:  I have written code to import a HyLogging-compatible dataset from Corescan hyperspectral image data.   It does spectra, linescan, prof, and core-logging scalars.   I only have one 2015 Corescan tray to work from at the moment, so my interpretation of things may be a bit dated and I don't know how an entire drillhole's files are presented.   I haven't written a GUI / wizard page for it yet.   Anyway it seems to work okay.
27 October 2017
New function: export ASCII XY files (one per spectrum).   Access via File -> Export
6 November 2017
New tool (with dialog): Import sample pictures (for field-spectrometer datasets).   Quite fancy IMHO.
I had to bump TSG's common-controls version to 6 for this.   That also brought in "themes".   That broke my log- and hole-column highlighting, and occasional checkbox colouring.   I found fixes for these issues but there may be others that I haven't noticed yet.   I haven't yet tried a Windows XP build for it either.
FXClust:  I also added a feature-extraction surrogate for the SWIR (which you can have the module do instead of drawing on pre-calculated featex scalars).
10 November 2017
A number of refinements to the sample pic importer tool.   I have now coded a basic "Exif" reader for Jpeg metadata.   The tool can sort files on the picture-taken date and it can import GPS from the pictures into TSG scalars.
I tried a Windows XP build and it worked on XP.
20 November 2017
Sample pic importer tool:  Refinements, documentation.
New floater pic-mode functionality:  If the pic has an Exif header then an "orientation" menu is shown and the user can change the orientation tag (which is saved back, and which TSG now uses).
Headless mode:  New job: Generate tray pics.   Not documented yet.   It was a bit harder than I thought because there were some GUI aspects to work around.   Also, there was a glitch where open-after-close wasn't working properly in headless mode.   This spoiled layout copying in the copy-process job.
New drag-drop:  Drop a script-file onto TSG to schedule a headless job.   Vied with dropping an ASD Halo summary file.   I wrote basic file checkers for Halo and TSG scripts to support this.
Low level I/O: closed the door "some more" to non-compact datasets.
21 November 2017
Settings: I took out "remember last directory".   I'm leaving this to Windows.
Scatter screen: New "linfit" option: "Annot, y=constant".   No actual fitting, just a y=c line for a typed-in "c" (on-screen field for "c").
Build 8-0-2-12 goes out.
24 November 2017
I'm preparing for a cleanup of TSG's system scripts.   Before getting stuck in I want to instate user script libraries.   To make a home for them in Settings I moved all the "aux-match" controls into a new settings page of their own and gave the "spec calcs" page a thorough working over.   I now have full dual-dataset support in the "spec calcs" page.   New controls for the VSWIR and TIR user script libraries are at the bottom of the page.   The basic user-script system itself is technically hooked up (basics done long ago) but proper testing will begin once I've made a couple of substantial user script libraries.   Then comes the cleanup of the built-in system scripts.   The "discarded" system scripts will go into a user script library that's distributed with TSG and maybe set as the default for Vis-Swir.   It will carry the same scalar UUIDs and ought to hook up to old script scalars in old datasets.
28 November 2017
Scripts:  User script-lib selection has a home in the revamped Settings -> Spec Calcs page.   It all seems to be working.   I have put the more advanced MES scripts (Carsten's collection) into a library.   That seems to be working too.
Important: I modified TSG's spectral-profile calc slightly, for the single-channel case (radius=0).   In this case its interval-bound-limited channel-identification mechanism could sometimes be 1 away from the nearest-wavelength mechanism that I prefer these days.   I have modified it to use nearest-wavelength match when radius=0.
1 December 2017
Scripts:  I have updated the script-language section in the main TSG manual.
Settings:  I fixed a glitch (a flow issue) in the preservation of CLS/TSA settings.
Licence: Reportedly, the "purchase" button in TSG's licence dialog was live for an unlicensed TSG8.   (A few people still "break sequence" and just download and install the setup program without registering on the server.)   The link could go to the shopping cart without a distributor ID.   Now it goes to our affiliates page instead.
5 December 2017
Edits to user script libraries.
11 December 2017
I reworked the scat-screen moving-average-overlay code.   I added support for choosing the colour of the scat-screen "linfit" overlay.
14 December 2017
Glitch fix:  State handled incorrectly in export sub-menu in right-click menus.
Some more work on script documentation.
Started on a generic inter-detector step correction module …finished .its first draft.
15 December 2017
I refined the de-stepper module a bit more (new scalar recalc option) and wrote documentation for it.
21 December 2017
Headless: DB upload was setting a default to Oracle dbase type instead of taking the system setting.   I cleaned this up and gave some more attention to the general headless handling of system dbase settings.
Batch scripts: Continuing with improvements here.   More script documentation done.   Settling on a way to handle script documentation, access and location (file or web).   New "Info" button in script page of scalar construction wizard - opens a web browser to the script's documentation if the script includes a "doclink" field.
15 January 2018
Settings:  A couple of updates ago I commented out the user-TSA-Calc line for some reason.   It's back.
QC: I fixed a crash that would occur if an FTP import trigger was received while the previous trigger was still being dealt with.
16 January 2018
I changed the way TSG looks for ancillary files like associated datasets, linescan rasters and profilometer files.   It had been stubbornly using the saved path+filenames (as seen in "Special Dataset Components") if they worked.   This could lead to great confusion when working with a dataset copy spun off to a local subsirectory.   The new search order is: 1] hard-coded filename alongside the dataset;  2] saved filename alongside the dataset;  3] saved path+filename, wherever it goes.   The first one that works is used.
New hotkeys: <CTRL><HOME> and <CTRL><END> for 3 floaters along the top or along the bottom.
22 January 2018
System:  I switched to ASCII XML format for saving / loading global TSG settings.   A total settings reset with a TSG version bump should be a thing of the past now.   Perhaps important:  I also changed the utility routine xspZapCRLF() to work with unsigned char instead of char.   It was turning ASCII bytes > 127 into spaces.
System:  Jon gave me preset mineral selections for the environment "Sedimentary Basin (not metamorphosed)", as a new column in The Master List (which identifies minerals known to TSG and standardises attributes like groups / subgroups / colours and so on).   I have hooked it up to a new right-click menu in TSG's standard mineral selection list.   It gives users a quick way to set to a preset selection.   Hopefully lists for more environments will follow.
29 January 2018
System:  Edits to the active mineral list in Settings->TSA are auto-saved to numbered (versioned) CSV files.   New: glauconite has been turned off in the “sedimentary basins” preset (even though it's a possible white mica) as it matches too easily.
List controls:  Recently, TSG started printing kanji (or something) for a list's selection text when there was no valid selection.   Fixed.
Licence:  I tried to reduce TSG's startup time.
30 January 2018
Doc:  New little doc on how to get TSG to create a startup log file.
Scratchpad:  ENVI lib import - now using dynamic L3 if resampling waveno->wavelengths or vice versa.
Featex:  Andy's featex algorithm was doing a wavelength(min) refinement together with a width refinement.   The width refinement could fail relatively easily, and in that case it didn't do a wavelength(min) refinement either but left you with the original channel-locked wavelength.   I modified it to do a standard 3-chan wavelength refinement, if at all possible, when the width refinement failed.
31 January 2018
Scatter screen:  New hotkey <ALT>Z for toggling scat sub quick zoom.
Floater prev / next navigation controls:  I removed the arrow buttons from the toolbar and put in a spinner control instead.   The new control understands what to do when the left mouse button is held down.
1 February 2018
Floater spectrum mode:  I added the option to include overlay plots of the spectrum immediately before the current one (in blue, dotted), and the spectrum immediately after it (in red, dotted).   It's controlled by a menu toggle.
New hotkey: <ALT><DEL> = reset all floater sizes and positions.
Layouts: The View menu now contains layout selections from both the primary and associated datasets.   (It has also been tidied up and now shows no unused layout "slots".)   If an associated-dataset layout is selected then the primary is closed and the other one is opened as primary with the requested layout loaded.
2 February 2018
Linescan loupe:  Glitches fixed.   Log-screen current-sample markers are now turned off while the loupe is up, and mouse-pointer locking to profilometer overlay isn't done anymore for the loupe.   Generally the loupe region clipping has been turned off.   (It was clipping the loupe to the log column's display area – an inferior look.)
6 February 2018
Import:  I added a preset to the Generic ASCII XY import to handle the Agilent .ASP ASCII format.
7 February 2018
I improved CLS scalar error reporting slightly (for debugging).   I can track them better now.
Dynamic import:  I added the new Agilent .asp import to this system.   It seems okay.   Note incoming wavenos and percent-reflectance conversion are hard-coded for this.
9 February 2018
Aux attach: I fixed a bug in the handling of group names in the "elite" aux attach.   (This is where the aux lib's samples all have "TableIndex" entries.   The attached aux lib can then drive domained CLS / TSA unmixing.)
Licence:  I added a bit to the startup log (which is a debugging aid).
Dynamic datasets:  Watch / move system doesn't delete old moved files of the same name anymore, but adds (indices) to filenames as required to keep all files.
13 February 2018
Central minerals table:  Updated with new entries for Andy's / Jon's external-lib session at the upcoming workshop.   There will be more updates soon.
16 February 2018
Class browse / edit (log & tray screen):  New scalar match option "HAS", for lexical substring matching in a class-type match scalar.
Floater CLS: bugfix, some changes (settings TSA active minerals) could lead to a crash (stale "mrsix" pointer in floater cls state structure).
20 February 2018
Agilent import: Straight waveno import was coming out backwards!   (Fixed.)
Tray screen:  New standard setup - alternate diagnostic view.
21 February 2018
SWIR TSAPlus:  Glitch fix (notably floater).   Plus' carbonate check requires a trained TIR TSADB.   For some reason I was not allowing it to train the TIR TSADB, so the carbonate check was not being done if the training hadn't been done.   I am allowing it now.
23 February 2018
Linescan loupe:  Now enabled during depth logging.   I don't see a reason for disabling it there.   I also increased the loupe’s minimum size.
Depth logging:  final-mask-toggle context-menu option added.
1 March 2018
Log class column:  If the class-item text includes an http or https link then a double-click will open a browser on it.
5 March 2018
Dynamic import:  Pima .DSP format added.
6 March 2018
FXClust:  I tried to clean up the management (display / destruction) of the eval-mode control panel.
More on cleaning up the entry into floater eval mode.
Spectrum-mode floater:  Fixed a spectral-cache glitch in the new before & after overlay option.   The cache was only being set up for the current spectrum and it could fail, e.g., when navigating "upwards" in the stack screen.
Drag & drop:  You can now drop an .ini (layout) file onto a main TSG window (with a dataset open) and the layout will be copied.   I also wrote a summary doc about TSG8’s drag & drop support, and put it on the website.
7 March 2018
Depth logging:  The IDL control panel is now a drop target for .TDL files (which it loads).
8 March 2018
Script revolution!
I removed many of the built-in system scripts, leaving just those that pass as "base" scripts and generally renaming them "2200W" style to dispel the idea of interpretation.   Then I added all of Carsten's base scripts.   I also included MFEM, MS_TIR and abandoned TSG7 script-library files and the script documentation files I have in the TSG distribution.   I cleaned up a thing or two here and there along the way.
13 March 2018
Import: Agilent wavelength correction option added.   Sub-dialogs off ASCII import and dynamic import.
Downsampler:  Wasn't recognising individual domained TSA class scalars properly - fixed.   Similarly, the newish class-result class-extraction scalar didn't have a class-type icon (etc) - fixed.
Some docs and things updated.
This is build 8.0.2.17, which goes out.
26 March 2018
Profile scalar:  New result type EB Wavelength at Minimum.   It uses an "extrapolated bisection" (EB) method to estimate the position of an absorption's minimum.   It is somewhat related to the "center of gravity" method that's popular amongst (high resolution) FTIR specialists.   I introduced it for the TIR polystyrene wavelength-calibration work but ended up mostly going with the usual simple prof method anyway.
Headless mode:  New job TPOLYCAL.   It reports on the positions of 8 Polystyrene TIR transmission absorptions.   It first uses a built-in polystyrene spectrum to find the best polystyrene candidate spectra in the current dataset by correlation match (could be none), then it runs a set of 8 built-in batch script scalars to find absorption positions.   These scalars have sanity bounds and all 8 features must be found for a spectrum to contribute (could be none).   Finally it reports the wavelength (nm) mean and standard deviation for each of the 8 features.   Like the "wvlcal" job it takes a report filename as an argument and appends to this report file for each dataset processed.
Tray screen:  Adjustment to depth ticks after a significant missing depth interval.
27 March 2018
Headless mode:  I reworked the "testrocks" wavelength calibration checker.   I got together reference mean spectra for mylar, pyrophyllite, kaolinite (WX) and talc.   I took out the hard-coded rock positions and instead made the module search for the requested target spectra (wherever they might be) using correlation match (with hard-coded thresholds and a second-stage pruning based on the best match).   The featext part is unchanged.   In the tests I've run, the results are much tighter than before because the target rocks are actually being found properly (instead of the assumed locations) so I think less "junk" gets in the mix.
I also took out the testrocks-only restriction.   You can run the job on any dataset and tell it to look for one or more of the four targets.   If the targets are found then their features will be reported.
28 March 2018
Tray screen - more tinkering with the depth-tick code to deal with missing-core intervals.
Menus / controls:  "Y sampling" renamed to "Sample height".
29 March 2018
Headless mode:  I modified the spectral matching in the TPOLYCAL and TESTROX tasks so that it won't fail if the host dataset has broader spectral coverage than the built-in standard spectra.
Basic:  I changed the setting of a dataset's "is thermal" flag, to work for extended-range Agilent spectra.
3 April 2018
ASD binary import:  TSG can now deliver radiance measurements from files that have DN along with base, lamp and foreoptics cal "spectra" embedded in the file.
4 April 2018
ASD import:  Updated to import "ABSREF" types.   These have the usual spectralon DN reference after the sample DN, but also have a spectralon absref calibration spectrum later.
Import:  I changed some low-level routines to preserve a non-standard (not reflectance) layer name coming in from whatever import module was used.
6 April 2018
Display:  I improved the positioning of various popup windows on multi-display systems.   (Some were pretty bad, e.g., scalar-selection-list popups.)
ASD import:  I added code to check for bad 1400 and 1900 regions (measurements in sunlight), and to interpolate over these regions if they are found to be bad.   Also the second step correction (usually around 1830nm) isn't done if the 1900 region is bad.   This check started life as being automatic but I relented and made a control (toggle) for "sunlight" illumination in the ASD import dialog page and the corresponding dynamic import's sub-dialog.   I also added an option to parse HoleID and Depth out of the filenames.   So far this is only in the main import - I must still add the controls and (different mechanism) scalar save for the dynamic import.
9 April 2018
Dynamic import:  I added the ASD import's new HoleID and Depth scalars from filename parsing.
Checklist dialog:  Some introductory text added.
11 April 2018
Arithmetic expression scalar:  I added two parameters: lower and upper result bounds.   The expression's result must lie within bounds (pending active) or it gets turned to NULL.   A bound is active if there's an entry for it.   A blank entry means an inactive bound.
Bounds checking is not done for logical-result repressions, or when both bounds are given but upper<=lower.
This new stuff is also in the batch world's "expr" method.   There, the new parameters (both optional) are "smallest=" and "biggest=".
NOTE this incurred a dataset version bump.   So, to commemorate, TSG8 Build 8-0-2-19.
Profile scalar:  Crashing bug, introduced recently with the "extrapolated bisection" result type.   Fixed.
13 April 2018
I updated the module suite for the recent changes to TSG's profile scalar (extrapolated bisection method), arith scalar (result bounds) and ASD import (various).
Adjustments to TSG's handling of latitude and longitude (especially in the ASD import).
16 April 2018
jCLST:  Bug fixed.   I had made a mistake in accessing result proportions in the third TIR TSA result-selection stage - where a TIR TSA result is pruned of any components for which the SWIR response is expected to be better and the controlling SWIR TSAPlus result doesn't have the component concerned.
17 April 2018
jCLST: Flow changed for when there is no valid TIR TSA result at the start or none that survives the SWIR moderation.   Instead of just going with an aspectral result, better-than-TIR-response SWIR-result minerals and scalar-result minerals can be added for the final stages.
18 April 2018
UI: Fixed a glitch in the handling of the default log-column format.
Assay import:  Addressed the problem of blank assay columns selected for import - they're skipped if the ISCN setting is on, otherwise they're imported as all-NULL scalars.   They don't halt the proceedings anymore.
Licensing:  Worked on the deactivation logic a bit.
19 April 2018
ASD import:  Substantial update to Halo export-file handling, for the case where the names within the export file are different to the actual ASD binary files' names.   In this case I'm matching on the last 4 chars (presumed sequence number) before any file extension, and checking that the matched file is actually an ASD binary file.
Mineral table:  Unbound & bound waters labels were the wrong way around.   Only cosmetic (labels in Floater CLS selection list).
I have moved on to build 8-0-2-20 today.   Build 19 is set for the Adelaide workshop.
20 April 2018
Licence:  Improved the error dialog shown when the licence is HASP-locked but the dongle isn't plugged in, and vice-versa.   I did some other licence work too.
Plots:  Proper date/time for axis labels when the "Relative date" scalar is plotted.   (Scatterplot screen only.)
23 April 2018
User batch-script library:  "ms_tir_scripts" library updated to version 4 with Jon's edits.
24 April 2018
Demo datasets:  I got this system working again.
Database upload:  Improved error reporting for the scalar upload phase.
1 May 2018
File basics:  I changed the flow of the assoc-dataset open, making it a little more robust.
Licence:  I changed some cosmetic things (e.g., splash-screen message) for workshop licenses.
Build 8-0-2-21 to celebrate May.
4 May 2018
Import:  I have a basic reader in place for the Chinese core-logging format.   I still have to do all the import-wizard stuff and the usual higher-level import stuff before I can start testing it.
Demo datasets:  More work on this.
Hole screen:  TSG8's Hole screen didn't accept a single-item class scalar for scoping.   Such as Hole ID in almost any NVCL dataset.   Did you see that?   Such as HoleID in almost any NVCL dataset!   Given one of these in an old dataset, it got changed to the first available "acceptable" class scalar.   This caused confusion when loading up TSG7 datasets.   Fixed.
7 May 2018
Licence:  I tidied up the display of "days left", splash screen and licence dialog.   I improved the handling of time running out.   And other things…
8 May 2018
PW updated TSGDBFunctions to ensure a compatible SQL Server driver is loaded before attempting any database commands.
9 May 2018
Demo datasets:  More work here.   I enabled the downsampler and the PLS screen, cleaned up the scratchpad save, and... some other things.
TSA calc progress bar:  I'm trying something new here to stop the thing from freezing when the PC is locked down with calculations.
15 May 2018
Thermal temperature-corrected spectral layers:  The early spectral cache set-up sequence could miss finding the "official" DeltaT scalar, causing it to fall back on empirically derived DeltaT.   Improved.
Layouts:  Sometimes there was an error of 1 in the save-load cycle of some scalar indices when mixed datasets could be involved.   e.g., Spectrum and stack screens when colouring by a scalar (which can come from either dataset).   Fixed.
18 May 2018
Import:  The first-draft Chinese Core import option is in.   Bare bones with no options and no image processing (just a straight image import to "linescan").
23 May 2018
Tray scalar:  A recent mod (pre-release earlier this month) was knocking out a special status bit for this scalar, offending a Tray-screen check and preventing the Tray screen from being offered.   Fixed.
Mid infrared:  I'm going to start looking at some sort of background correction for this.   I've started to add a more generalised constrained-fit call in the module suite to help with this.
1 June 2018
Import:  I'm well into cleaning up the import code in preparation for starting on some "headless" import options.
Licence: I simplified the ID checking to make TSG's implementation more robust, e.g., to changes in virtual internet adapters and the like.
Modules:  I added a new little constrained fitting front-end to assist in upcoming MIR background-modelling experiments.
5 June 2018
First-stage cleanup of the import code is done.
6 June 2018
SWIR TSA Plus:  I had an override, forcing at least mix3.   I've softened this for User SWIR, allowing mix2.   Not everyone wants mix3.
Merge:  Slight modification to conditions when a user TSA recalc is forced.
7 June 2018
TSA:  Domained SWIR TSA didn't have allowed-mixtures filtering.   It does now.
Licence:  Although the automatic daily licence check includes a TSG version check, it wasn’t reporting anything if it found that the running TSG wasn’t the latest version.   (The reporting had been commented out for arcane technical reasons, like complications in “headless” mode.)   It is reporting this now.
12 June 2018
Build 8.0.2.24 goes out today.
20 June 2018
Source management:  I reorganised documents.
Depth logging:  There were issues with the "bounds" calculations, especially when section-start-end DEPTH markers were involved.   I reworked the code.
25 June 2018
Headless:  The "Polycal" job has been upgraded to do a Vis-SWIR calibration check when given a Vis-SWIR dataset.   (So it now has separate TIR and SWIR checks)   It's based on the new Vis-SWIR calibration puck that will be rolled out to NVCL HyLoggers.   Built-in match spectrum;  cal check on 25 features across the range.
I'll have to rename the job now, and update the docs.
29 June 2018
Some work and bits for modelling MIR backgrounds (esp. with water).
New option in headless scheduler:  run now.   Fires up a separate headless TSG under the user's login.
4 July 2018
ASD import:  I added an option to create import-time scalars from the instrument serial number and integration count in the ASD headers.   I also turned the "parse filenames" checkbox into a list and added a new option to extract (Anglo Gold style) sample IDs from the filenames and make an import-time scalar from it.   These changes are in both the main import and the dynamic dataset import.
6 July 2018
Headless ASD import:  The basic module is in and appears to be working.   So far I only have it creating new datasets - I haven't done the append-to-dataset option yet.   Also I haven't done any of the headless script work yet.
9 July 2018
GFX:  I reversed the "mirrored rainbow" colour palette.   It is now red at the extremes and blue in the middle.
12 July 2018
Headless ASD import:  Append mode is done (via dynamic import support routines), and the script support is done too.   Documentation awaits, in its hiding place there in the future.
13 July 2018
Headless mode:  I updated the documentation.
16 July 2018
UI:  I gave each floater window its own little top-left "system" icon (instead of the standard TSG icon), and match the icon in any dialog that is brought up for the floater.   This makes it possible to see which floater a dialog relates to.
18 July 2018
UI:  The Domain editor and its sub-dialogs are now icon-tagged.
19 July 2018
Headless:  I coded up a little email sender using simple MAPI but it's no good because Windows pops up a yes/no security dialog.   I won't be using it.
Headless:  I added a looping mechanism to the whole script (all tasks in the script).   I modified the system so that the import task can pass the name of its output dataset on to subsequent script tasks for them to use as their input dataset, and to skip subsequent tasks (in that loop) if nothing was actually imported.   I updated the documentation.
I/O:  There was an issue where simple datasets created by old TSG Pro carry an ID that says "made by Pro" and TSG8 goes read-only with them.   The details are messy and are to do with the nest of licensing options I put in when we were setting up for TSG8 Pro, Advanced and Core.   I have a fix but I don't want to scuttle the logic completely in case we go back to this product line sometime.
20 July 2018
Headless:  I have coded a SHELLEXEC task that fires up some other process.   (For example it could fire up a Python program that does something with a headless downsampler output.)   It seems to work, but I haven't documented it yet.
23 July 2018
Headless:  Documentation updated.
24 July 2018
Profile scalar:
New method: Centroid Wavelength at Minimum.   I also reworked the EBWMIN method's FWHM-finding logic.
New parameter:  MINRAD, which means "minimum relative absorption depth".   So it's a Q/C filter, and it's available when local continuum removal is turned on (for methods that support local continuum removal).   Yes, the Profile method has a Q/C filter now!
Profile scalar:  I also added the recent changes to the module suite.
I note that the new MINRAD parameter incurred a dataset version bump.
30 July 2018
Cal:  When a single testrocks dataset is imported, the new "puckwcal" module is run and, if it finds its calibration targets, calibration results (wavelength centre & stddev) are saved to the new dataset's "executive summary".   This is done for both VSWIR and TIR.
Modules:  Sanitisation of structure names to avoid collisions with TSG once TSG starts calling the suite itself.   Some work on a new dataset definition.   (This new-dataset-format work will continue in the background.)
31 July 2018
UI:  I expanded the recent-files menu set from 7 to 16 entries, and made a new sub-tree in the main File menu for them.
1 August 2018
When TSG QC imports a TestRocks dataset that includes the new calibration pucks, it pops up a wavelength calibration report.
7 August 2018
Modules:  Chipping away at the new dataset format.
Licence:  Some attention to the first-time-activation checking.
Stats:  Added an option to "zero the mean".   Andy's suggestion.   This may help to reduce the pulling apart of spectra that have similar shapes but varying intensity.
15 August 2018
Import:  Resampling is now forced on when the incoming spectra have reverse-order wavelengths.   This gets such spectra imported correctly (i.e., it's a bugfix).
Floater CLS:  Some attempt at normalising the displayed proportions to be more like the calculated scalars (a mixture-level challenge).
Modules:  More work on a routine that converts an existing dataset to a new format, which is under development.
UI: Fixed a bug in the handling of the recently-expanded recent-files list.
Domain editor:  Disabled if the dataset is sorted.
17 August 2018
TSA:  All TSA activity is knocked out for datasets that have fewer than 30 scalar slots (very coarse-resolution datasets).   The import of such a dataset used to fail because the TSA calc failed to create its scalars.
22 August 2018
Stack screen:  Jon found a glitch where a sub's customised scale gets reset when switching focus to another sub and then back.   Fixed, but it was more complicated than I thought.
GUI:  I spent some time sorting out the positioning of popup menus and dialogs on my multiple-display system, which "goes into the minus" horizontally.
24 August 2018
Floater: Window title-bar text “improved” for TSA/CLS mode.
Aux attach:  I reworked the system to be kinder to users of primary + assoc dataset pairs.   E.g., If you drag & drop a TIR aux dataset onto a floater, it’ll probably get attached even if the floater is set for the Vis-SWIR dataset.
29 August 2018
Depth logging:  I reworked the “bounds” code that recalculates tray start- and end-depth for all trays.   Part of this re-worked code is also used in the recovery-rate scalar's calculation.
31 August 2018
Modules: I'm probably at the point where the new-format metadata writer is done for now, and I can move on.
4 September 2018
Modules: Attention given to Unicode support.
5 September 2018
Modules:  more text work.
Scatter screen:  The virtual [Set weight] scalar that accompanies set scope has been reworked to be like a class-extraction scalar. It used to be the largest single weight found for a sample’s [Set mineral] but is now the weight total for all occurrences (all mixing levels) of a sample’s [Set mineral]. For a group rather than mineral scope there is an option in File->Settings [Sys] to make it a group rather than mineral weight total.
7 September 2018
Settings:  I have reworked the recalculation of scalars that depend on a modified spectral layer.   A failed scalar recalc does not short-circuit the proceedings anymore.   Instead, the module just alerts you to such failures.   (An example failed recalc: an auxmatch scalar for which the aux dataset can't be found.)
Modules:  The unicode revolution continues.   I switched to unicode for the build and ...worked my way through most of the bugs.   Remaining code issues are with the IDL front-end that I use for testing and I don't know if I'll fix that as IDL doesn't do unicode anyway.   Otherwise my SWIR spectral-library "include file" won't compile because the string of spectrum names is more than 64K!
10 September 2018
Modules:  I added unicode conversion as necessary to the IDL and LabView interfaces, and sorted out the spectral-library "include files".   I have a clean unicode compilation.
11 September 2018
Dbase:  PW fixed pre-upload holeimage validation.
12 September 2018
Modules:  The generic file reader has half-decent text conversion, but only on Windows.   Its non-Windows conversion is still very crude.
14 September 2018
Dbase:  Attention to preserving HyLogger machine name / ID;  "Custodian" field length increased from 48 to 64;  attention to preserving non-standard LUT for TSA scalars (requires scalars to me marked as changed, e.g., by changing the LUT, and uploaded).
Setup: If the setup program is "run as administrator" then a dialog is put up at the start, asking the user to confirm admin mode.
Build 8.0.3.3.
20 September 2018
Further attention to NVCL database issues, focussing here on remembering colour palettes for TSA scalars.
New TIR and SWIR candidate library spectra received from Monica.   I haven't yet started the process of building test libraries with them.
Further work on the new dataset format.
21 September 2018
Downsampler:  When downsampling scalars on Index with a bin size of 1 and outputting to CSV you get 2 new columns on the left:  "Sample_Name" and "Sample_Comment".
26 September 2018
Goto tool:  When working off the Index scalar with the "equals" operator you can now enter non-numeric text, and if you do then the tool will do a lexical substring match against sample names, returning the index of the first sample matched (or doing nothing if no match).
28 September 2018
"Edit scalar names and groups" dialog:  I hooked the internal / published toggle to scalar groups, allowing the published status to be toggled for all scalars in the selected group.   The action does not travel down subgroups within the selected group though.   For a group, the button is still a toggle but its name varies:  "n/a" (no scalars in this group);  "none published";  "some published";  "all published".   "All published" toggles to "none published".   The other two (ignoring "n/a") toggle to "all published".
Modules:  I'm using the MIT-licensed "jsmn" code to parse JSON format, in prep for a new-format dataset-open call.
This is build 8.0.3.7.
3 October 2018
Layout copying:  Scatter-screen set-virtual scalars were not being handled.   Fixed, but there is no advanced range handling.   (No template ranges are used here.)   Summary-screen and hole-screen layout copying should be working now.
Build 8.0.3.8.
Modules:  Work on a dataset reader continues slowly.
4 October 2018
Scalar scripts:  The 'psclr' method can now (optionally) operate on script-scalar inputs instead of spectral channels.   The main TSG help file has been updated for the change.
e.g., return = psclr, parmode=YES, redparam=P1, redmin=0, redmax=0.15, redinv=NO, greenparam=P2, greenmin=0, greenmax=0.075, greeninv=NO, blueparam=P3, bluemin=0, bluemax=0.15, blueinv=NO
5 October 2018
Modules:  Working on the dataset reader.
18 October 2018
Modules:  Work on the new-format dataset reader continues.
Settings:  Affected batch scalars are now also recalculated with a spectral layer recalc.
19 October 2018
Floater scratchpad:  You can now have the spectra in different colours.   (There's a new menu item for enabling this.)   The default palette is TSG's "brighter thematic" 128-colour palette but there is an on-screen button that lets you customise a spectrum's colour.   The list is coloured too.   These colours are saved and loaded via a custom "plotcolors" section in the ENVI spectral library file.
22 October 2018
Floater scratchpad:  Minor adjustment to colours.   Normal thematic default (not brighter thematic);  less aggressive darkening on a white background.
25 October 2018
Modules:  The first draft of the JSON-format medatadata parser is done and seems to work.
29 October 2018
Set a status message to inform users when waiting for a response from a boreholes WFS and set a timeout of 20 seconds to stop failed checks blocking for ever.
31 October 2018
Corescan:  I have seen another collection of Corescan HS data, this one including several drill-holes.   However there are no XML metadata files at all.   I had to modify my import suite to make do with what info they can draw from the (basic) ENVI header files instead.
The test import appears to work, so now I'll create a front end for it.
5 November 2018
Corescan:  I have finished the front end (in TSG's Import wizard) for the Corescan import.
Utility:  A client got a memory-allocation error when trying to sort a large dataset.   I have modified the sort routine to use a temporary file instead of a memory allocation for sorted spectra.
9 November 2018
Settings:  There's a new option in [System] to have the Dataset Info [Description] dialog shown on dataset open.   This new option does not get preserved in the NVCL database so it is set on download if a dataset's executive summary contains a non-trivial amount of text.
14 November 2018
Corescan:  I added an "offset" setting to the Corescan import.   This enables one to position the extraction window away from the centre of the section.   I also added "headless" support, allowing one to import many HCI drillhole datasets.   This uses a new a "directories" option in the headless system's multi-file handling.
16 November 2018
Corescan:  Some embellishments to the Headless task;  headless documentation updated.
28 November 2018
Floater feat freq:  Two new plot types - global scatter (all features) and gridded scatter.   They can navigate the current sample in other plots.
Downsampler:  Stray commas could make it to expanded class scalar names and ruin the CSV output - fixed.
CSV reading:  the text "inv" is now handled like "null".
30 November 2018
Auxmatch scalar:  Bug fixed in the routine that checks for overlaps (and corrects things) in the wavelength-subsetting intervals.
4 December 2018
Dynamic import:  Log-screen column plot (X) ranges are preserved - not reset by an import.   (User request.)
5 December 2018
Dynamic datasets:  Hidden feature-extraction scalars were getting wiped out during dataset expansion.
6 December 2018
Floater feature frequency:  I enhanced the little control panel to include wavelength & X range fields, and a scatterplot dot-size selection list.   (No need to bring up range and linestyle dialogs for these now.)
10 December 2018
Feature frequency plot:  I fixed the handling of "default".   I also put in a non-linear colour stretch for the scatter plot.
12 December 2018
This is build 8.0.3.16, which goes out.
13 December 2018
Central minerals table updated for a new arrivals (lithium minerals).
A glitch or two fixed for the FFC scatterplot:  Range fields when there is no Depth scalar and Index is taken instead;  Mouse-cursor lookup when X range is wildly different to Y range.
Occasional crashing bug in sample deletion, seen once with single-sample deletion from a dynamic dataset.   Maybe fixed (hard to repeat).
Settings[Aux] is brought up automatically after an interactive aux attach.
14 December 2018
Regarding the wavelength calibration check that is supposed to be run when a TestRocks dataset is imported:  The "is this testrocks?" check was being done on the HoleID scalar, which was expected to be "testrocks" - but was at the HyLogger operator's mercy.   So the check could fail.   I now have the import pulling out the second ";TrayName" tag from the AUX file, and setting the hole name to "testrocks" if TrayName is "testrocks".
Floater auxmatch - plot was failing when the host dataset's wavelength units weren't nanometres but the "plot in nanometres" option was on.
Small fix to generic ASCII dynamic import - less intolerant wavelength-range checking and (actual) support for "header lines" and "percent" options.
17 December 2018
Dataset encryption:  I added a check for free space (dynamic datasets), which isn't allowed in encrypted datasets.   Also, up to 128 encrypted-dataset passwords are remembered in the global ini file.
18 December 2018
Checklist journal:  There now an option to delete the journal, e.g., to protect I.P. in processing.
19 December 2018
Aux library unmixing:  Some clean-up.   Wavelength-interval subsetting defaults;  system TIR carbonate support in SWIR TSAPlus matching.
20 December 2018
Floater feat freq:  current-sample markers done.   Depth max bound changed to a colour clip for the scatterplot, and to a depth clip for gridded depths.   (Still an exclusion threshold for the histogram though.)
14 January 2019
Import / export:  The "Euro-style CSv handling" global option in File->settings[System] has been hooked up to the ASCII XY import, specifically to handle the case of oreXpress files that had commas instead of decimal points.
Summary screen:  Some behind-the-scenes work on a new "difference" plot type (which will show the differences between two result sets).
16 January 2019
Summary screen:  The difference histogram plot is ready for testing.
Modules:  A little attention to the "_copysign" function, which might not be included on unix platforms.
18 January 2019
Feature frequency scatter / grid plot:  There's now an option to rotate the plot so that depth (m) goes down Y.
Spatial summary plot:  There's a new option in File->Settings[System] to have raw bin totals instead of percent in the exported CSV (user request).
21 January 2019
Feature frequency plot:  The dialog is now modeless.
Feature extraction:  On rare occasions the fitted wavelength for a weak feature could be noticeably outside the host spectrum's wavelength interval.   Such features are now skipped.
22 January 2019
File save-as:  Layout files are now copied as well.
24 January 2019
Viewer mode:  Fixes to names in scalar-set lists and Summary-screen plot titles.   (e.g., "System jCLST" was named "System TIR TSA" in the lists and plot titles, and plot titles did not show the TSA version.)
Residual layer:  Not labelled reliably ("CLS" vs "TSA") in the Log-screen selection list.
Settings[Featex]:  Method list items renamed a little and reordered slightly.   Also, online manual's description of methods corrected slightly. 
Modules:  Some work to get a clean Unix compilation again.   (It appears to work, even with all of the Unicode-option changes.)
25 January 2019
I'm working on an automatic scalar script builder.   I think I have the workhorse routine coded and working, with the 4 main script methods in place.   Auxmatch and Import must still be done.
29 January 2019
Scalar script builder:  I have done the last two methods, Import and Auxmatch.   Now I'll start working on a dialog.   (I've decided to give the tool a proper home under the Edit menu.)
30 January 2019
Automatic script builder:  I created a dialog for the tool and hooked it up to the Edit menu.   I made some refinements.   It looks okay.   There's even a pop-up help dialog.   Pre-release build 21.
5 February 2019
Scalar script builder:  Some tweaks.   First daft (!) documentation complete.   It's ready for further testing.
6 February 2019
Floater feat freq mode:  The control panel now has a scrollbar under the wavelength-range fields, allowing the active 'window' (sub-range) to be moved simply.
8 February 2019
Floater feat freq: The scatter plot can now be coloured by an "aux" scalar (class or numeric) instead of feature depth.
Summary screen:  Plot navigation got messed up for the lower plot after a clipboard copy if it was a spatial / difference plot with a "ribbon".   Fixed.
Domain editing:  The recalculation for changed Restricted Mineral Sets NULLS out an affected result set's scalars before the recalc.   This was being done early in the piece, before everything was checked, and could leave an "external" CLS/TSA result set NULLed out if the external lib could not be found / wasn't attached.   Fixed.
11 February 2019
NVCL TestRocks cal check: Two of the seventeen VSWIR checks were dropped and the cal-spectrum location threshold was reduced slightly.   This because of slight differences in recent chip-logger cal measurements (compared to last year's HyLogger3 measurements and probably due to the lower spectral resolution of the chip logger’s old ASD).
Floater feat freq:  VLine functionality added for rotated scatter and grid plots.
12 February 2019
Script builder:  Some tweaks.   With the NVCL option the script doesn't have a header or comments and it includes a SPECTYPE field to tell the analytics engine which spectral log to fetch.
Modules:  Corresponding update to tolerate the new SPECTYPE script field.   Glitch fixed:  A structure member was named "complex" and Visual C started to take exception to that.   It's called "complx" now.
13 February 2019
Modules (PW):  Fixed jni unsatisfiedlinkerror issue.   Fixed TCHAR issue.   Added Makefile for linux compile
14 February 2019
Dataset merge:  In many cases the merge was neither copying TSA scalars nor calculating them!   Fixed.
Summary screen:  The "use TSA abbreviations" colourbar setting now works for overview x-axis bar names too.   (They always used to use abbreviations if present.)   Now they can show full mineral / group names, but only when there are 16 bars or less.
Dataset encryption:  I modified TSG to allow a "blind" (no plots) aux attach with a high-level-protection encrypted dataset, so that external CLS / TSA scalars can be calculated from it.
15 February 2019
Feature extraction, minmax method:  Any feature on the very first or last spectral channel is discarded.   Spectrum screen feature-tag sorter fixed up to handle negative depths properly, and tag limit increased from 16 to 24.   FeatEx scalar returns signed depth now (not ABS(depth)).
18 February 2019
Floater feat freq:  Slider added for X sub-range view position, to complement the wavelength subrange one.
20 February 2019
Corescan import:  Basic junk filter on incoming Corescan spectra.   Only accepts spectra that have a range within [0,1].
22 February 2019
Modules:  Changes for linux compilation.
25 February 2019
Summary difference plot:  glitch fixed in result-set list handling.
26 February 2019
Floater scratchpad:  Fixed a crashing bug that could happen during the deletion of an overlay selection.
4 March 2019
Tray-screen Rockmarks editor:  It can export to CSV.   (There's a new button...)   The CSV has columns Index, Depth, Hole, Tray, Section, SecDist, Rockmark tag category, Rockmark description.
This is build 23.
6 March 2019
TestRocks related:  I centralised the "is this a TestRocks dataset" test as far as possible.   The test done at the end of a single-file SDF / SDS import is still tighter though.   (I also hooked up the test for "dataset info" at the end of an SDF import - it used to be just for an SDS import.)   Then I made the test routine tolerant of missing cal features and reverted to the 17-feature SWIR check (not 15).   Finally I tidied up the text report a little.
14 March 2019
Settings: There are now two sets of aux-match controls - one for each dataset in a pair.   (There used to be aux-match controls for the primary dataset only.)
External TSA unmixing: Many more small internal changes to support external TSA more tightly.   External TSA spectral residuals are now supported.
Linescan trimming:  Alan got this to crash somehow, but I couldn't repeat it.   I have wrapped it in an exception handler and issue an error message with a stage indicator so I can track it better if it crashes again.
Build 24.
25 March 2019
Floater feat freq:  When features are provided by the 'minmax' algorithm, the control panel provides 'troughs' and 'peaks' checkboxes to control what to show.   The depth-filtering controls still (for all choices) filter out features with small absolute depth, and filter out (histo) or colour-clip (scat/grid) features with large absolute depth.   A 'dead centre' colour table is used for scatterplots when both minima and maxima are plotted.
1 April 2019
Modules:  trying to find what causes a crash (64 bit).   PW:  Fixed Java_org_auscope_nvcl_server_util_TsgMod_testParseOneBatchScript function to return negative values on failure.   Fixed some function naming issues.
2 April 2019
SDS import:  Added an option to do VNIR-SWIR step correction, which can be used if the HyLogger was run with its step correction disabled.   (Diagnostics.)
Resampling:  Changed the default number of Lanczos lobes from 3 to 4.   3 can battle occasionally with sparse inputs.
Experiment:  Tried a frequency-domain correction for "channel spectra" - oscillations due to thin films.   It didn't work out.
Experiment:  Tried a couple of those "high DPI" approaches to get clearer (e.g., menus) screen scaling on high DPI screens.   They didn't take.   I think that TSG's residual Windows XP compatibility is holding things back.   It's a tough cord to cut, what with the HyLoggers stuck with XP for the time being.
New build:  8.0.3.25.
…I changed my mind.   It is build 8.0.4.1.
4 April 2019
Feat freq:  Fix to colour clipping in minmax scatterplots.   Fix to statusbar readout on wavelength-subsetted histogram.
General, low-level internal:  I fixed a bug in a routine that checks whether or not a given scalar is a TSA scalar.   (Recently-introduced bug which didn’t work out and was sent packing.)
PW:  Reused tsgGetProxyInfo from tsgreg.c to detect and use a proxy server for borehole URI resolution.
5 April 2019
Licence / other:  I gave tsgGetProxyInfo() a new parameter for an optional target URL.
Tidied up the 'About TSG' dialog.
8 April 2019
Scalar scripts:  The import method did not work on ‘aux-match’ scalars that used CLS/TSA unmixing on one of the built-in libraries.   (It works now.)
9 April 2019
Formal release of 8.0.4.1.
Started work on a utility to copy a scalar set.
10 April 2019
Scalar sets:  I modified the "delete scalar set" tool.   In the past it could just delete a set definition but not the scalars within.   Now there's an option to delete the definition and scalars.   I have also finished the routine that copies a set+scalars (e.g., a TSA result set) to a user scalar set+import-type scalars.   Next I'll give this new routine an interface.
11 April 2019
Scalar sets:  The "copy scalar set" function has a dialog and is hooked up to TSG's menu.
XP build: It didn't actually work on XP because of the use of a function to read regional settings.   Fixed.
TSA: There was a glitch (newly introduced) that caused TSA scalars to be marked for recalc when they didn't need to be.   Fixed.
This release (8.0.4.2) is a formal hotfix release.
12 April 2019
User scalar sets: A floater in TSA "multiple result" mode will have a menu "replace result in user set" if there is a user set that is "like" the TSA that the floater's currently working with.   For example if you make a copy of User SWIR TSA to a user scalar set and you have the floater in System or User TSA mode (which are both "like" your user set) then this option will be live.   You can select any of the results shown in the floater's multiple result list to update your user set (for the current sample).
17 April 2019
I've started adding chemistry support.   I received some data and experimental IDL code from Andy Green, and fleshed out the data so that most entries in TSG's central minerals table now include elemental breakdowns and densities.
23 April 2019
General:  I moved the daily check's 'there's a TSG update available' messagebox out of the main initialisation routine (where it was not able to offer to do the download) to a timed call.   So now it can offer to do a download.
PLS:  I added various checks to the load-session call and wrapped it all in an exception handler.   (There has been a problem report or two but I haven't been able to repeat such.)
Chemistry:  The master table now has elemental breakdowns for almost all of its minerals.   My next step here is to offer element readouts / plots for unmixing results.
1 May 2019
Chemistry:  The Summary screen offers a third plot level 'elements' (in addition to 'minerals' and 'groups') for Overview and Spatial plots, given an unmixing set based on a library with trackable spectra (like the system libraries).   Currently the elements are volume fractions.   Weight fractions are still to come.
Featex: 'The Green Machine' for TIR would return a channel-locked feature wavelength if the feature was too narrow for its liking.   I have added a fallback wavelength fitting step for such features.
File selection:  The Windows file-selection dialog would fail quietly if given a default (incoming) file spec that included a forward slash.   This could mean lock out if the bad default was remembered by TSG.   (This has been responsible for some PLS issues.)   I added a filter for this.
3 May 2019
Feature extraction:  Fix to TGM TIR Fx algorithm.   A bug (of mine) spoiled the wavelength fitting refinement stage.
Chemistry:  I now have JMOL colours for the elements.   This might well change, though.
7 May 2019
Chemistry: The Summary screen's difference plot can now do elements too, given suitable scalar sets to work on.   Also I changed this plot’s item matching from lexical to central mineral index in cases that support these indices.
10 May 2019
Chemistry (and other):  There's a new tool:  Edit -> Scalar sets -> Play out a scalar set into scalars.   It creates a squad of mineral, subgroup, group or element scalars for the selected scalar set.   It creates these scalars in the set’s scalar group and only creates the ones it needs, recycling existing scalars if they are found.
Build 8.0.4.6.
20 May 2019
Headless:  The CLIMPORT task also handles HyLogger SDF and SDS now.   Documentation updated too.
Dataset info:  The dialog’s TSA tab now handles both datasets in a pair.   (It used to handle just the primary dataset.)
Build 8.0.4.7.
22 May 2019
Scatter screen:  There's a new option to rotate a histogram subscreen 90 degrees clockwise.   The 'X' scalar then goes *down* the Y axis.   (Histograms commonly have depth on 'X' and geologists like to see depth increasing downwards rather than sideways.)   It's in the 'Hist extras' menu.
Also, possibly for this build only, 'minmax' feature extraction is done on the normalised reflectance layer rather than plain reflectance.
Build 8.0.4.8.
24 May 2019
Chemistry: Now doing weight fractions instead of volume fractions.
Summary screen:  I reworked the Overview-plot code.   In a weighted histogram, sample tile heights in any one bar were shown as all the same in colouring / sample location.   Now they vary according to individual samples' weight contributions.
31 May 2019
Summary screen:  The Spatial plot now has full sample-level mouse-cursor tracking and current-sample markers (major reworking under the hood).
Floater FFC:  The current-sample navigation between it and TSG-at-large has been a bit hit-and-miss.   I found something to improve but it might not be the end of the story.
3 June 2019
Dataset info: The 'Description' page now supports dataset pairs.   It has radio buttons along the top to select a dataset.
4 June 2019
Summary screen:  Mousing around on a spatial / difference plot's colourbar will cause the current colourbar block's class to be highlighted where it occurs in the plot.
Fundamental:  The central mineral table had the maximum response value in both SWIR and TIR for pyrophyllite.   The TIR value has been taken down a notch so that SWIR can override TIR for pyrophyllite in jCLST matching.
Scatter screen:  Tweak to scatterplot dot-size rescaling.   (The last two dot sizes came out the same for a full-screen scatterplot.)
Build 8.0.4.10.
5 June 2019
Layout copying:  Small change for Summary screen's Spatial plots, X handling.   If the template plot's X range has not been subsetted then TSG will use the target's X range without attempting to use the template's.
Scatter screen:  Scatterplot dots on plot edges are not stupidly clipped 'on the wrong side' anymore.
6 June 2019
Scatter screen:  The new histogram rotation option was messing up for normalised histograms - fixed.
Aux attach:  I've started work on an option to attach an aux dataset as an extension to one of the built-in libraries, for use in unmixing.
13 June 2019
Aux attach:  I've completed (until proven otherwise) the option to attach an aux dataset as an extension to one of the built-in libraries, for use in unmixing.   This aux dataset can just include a few suitably marked up spectra to add to the system library concerned (chosen by the aux library’s coverage).   Under the hood, an in-memory extended aux dataset is created and attached for the session.   This aux dataset can only be used for creating external ‘custom’ unmixing scalars at present (fitting in with our SWIR library restriction).   It needs documentation now.
PLS prediction: I took out the (ridiculous) requirement on input-side scalars, where if any input scalars were used then no NULL values were allowed in any of them anywhere.
Summary screen: The option to map junk items to NULL was not enabled for scalar sets that weren't official TSA ones (like TSAlib-derived CLS sets).   It's enabled now.
Build 8.0.4.11.
21 June 2019
Downsampler:  The ‘Absolute’ option now works with the ‘Expanded’ option in scalar downsampling.   (‘Expanded’ is used to play out a class scalar or consolidated set to one output scalar/column per class item, e.g., one column per mineral.)   Expanded normally delivers normalised fractions, where the values in one row (e.g., one depth interval) sum to 1.   With ‘Absolute’ it leaves them un-normalised.
Summary screen overview:   A bug was introduced in a recent change.   Overview-plot bars were not scaled properly and commonly rocketed way past 100%.   Fixed.
Build 8.0.4.12.
27 June 2019
Log screen, new standard setup added: 'Best' VNIR, SWIR and TIR 'TSA'.   'Best' means 'User or if not present then system'.   'TSA' can mean plain or domained jCLST for TIR.
3 July 2019
Tray screen:  Pic generation could fail with an error.   Ultimately caused by a dependence on the screen plot being done first (automatically), for each tray, and by TSG getting so locked in to the job that Windows sometimes doesn’t bother showing screen updates.   This dependence is gone now.
Assay import:  Null handling tidied up a little.
Build 8.0.4.13.
4 July 2019
Aux attach, extension libraries: Tidied up a bit.   Extension-library samples are automatically ‘whitelisted’, provided that they aren’t ‘blacklisted’ by the analyst.   By ‘whitelisted’ I mean that they are active until turned off in the Domain editor.   The master table’s default active / inactive status is ignored for them.
First-draft documentation done.
5 July 2019
Spatial summary screen, current-sample markers:   Awful little bug.   The current-sample markers would go slightly daft on a plot where minor items had been filtered (‘subsetted’) out.   Fixed.
Chemistry: I've started working on the support for customised library-sample chemistry.   (That's where a library sample has its own chemistry, to be used instead of the mineral's default.)
8 July 2019
NVCL support:  Fixed image histogram upload for linescan image logs.
9 July 2019
Feature extraction:  There's a new setting to select the input spectral layer for the MinMax algorithm.
Unmixing:  Custom mineral chemistry is being parsed where present, and is now carried in the unmixing structures.   It is not yet in active use though.   It is held at the unmixing class level (below the reported mineral level) so at this time it is really for TIR libraries (not SWIR) but that makes sense anyway.
10 July 2019
Summary screen:  There's a new subsetting option for Overview and Spatial plots - 'maximum column / bin %'.   It can be used to leave out the 'bigger' items so that just the little ones (e.g., rarely / sparsely occurring minerals) are plotted, and any occurrence patterns they might have are shown more clearly (in a spatial plot).
11 July 2019
Main toolbar:  New button to refresh the current screen.   It's more thorough than a simple 'paint'.
Floater CLS 'fitting studio': New button 'Chg1' = 'change 1'.   It will change any one item (unmixing class) in the current selection if it improves the fit.
17 July 2019
Database:  Separated default and custom script download for scalars with standard algorithm definitions.   This allows better control of the scripts used.   Changed database upload to allow reloading of the main imagery if the user requests it.   Fixed a bug with the size of the memory buffer used to hold linescan image histograms.   Finally, the upload could trip up if no tray pictures are present.
Floater FFC:  Should now update when the FX method is changed in the main Settings.
jCLST TIR unmixing:  A valid SWIR result now has MINERAL-level control over alunites.   (We tried this for kaolins too but there are issues, so not yet for them.)
Gfx export:  I've started on some basic work towards finer control over gfx exports from some TSG plots.   JPEG and PNG files now carry "DPI" metadata.   For the time being DPI is just hard-coded at 300.
Build 8.0.4.14.
18 July 2019
Database:   Small fix to yesterday’s fix.
Build 8.0.4.15.
19 July 2019
Custom unmixing:  I added jCLST to the choice of algorithms, given a TIR external library and a VS+T production dataset pair.   I fixed a glitch in the lib-extension wavelength coverage.   (e.g., An extension lib with [6000,14500] coverage kept some sense of this coverage when extending the built-in [6000,14000] TIR lib.)   I fixed a bug (quite subtle and nasty) in the RMS list editor's handling of backup lists.
22 July 2019
Changed image histogram saved in the database to an image histogram lookup table.  This makes it smaller and easier to work with.
23 July 2019
Floater Feature Frequency mode:  Some adjustments, mostly in auto range handling.
Domain editor:  Fixed a glitch in undo handling.
Build 8.0.4.16.
25 July 2019
Database:  Fixed a bug with the image histogram download.
26 July 2019
Headless mode:  Support in DBUPLOAD for repeated (not just first time) linescan upload.
Database:  Minor GUI adjustments.   Fix to proxy check.
29 July 2019
Database upload:  Improved the handling of read-only datasets.   Earlier checks, including an explicit check on the assoc dataset.   Clearer error reporting.   Documented Headless mode's UPDATEOLDFMT option.
31 July 2019
Headless mode:  Useful new 'Summary' section at the end of the log, listing pass/fail status for each dataset (multi mode only).   Adjustments to the database upload task.
Build 8.0.5.1, which is likely the next formal release.
1 August 2019
GUI: Workaround for Windows multi-screen glitch, affecting right-click subscreen selection (Scat/Hole), Scat sub move dialog and Domain editor 'ribbon' tracking.
Formal release (build 8.0.5.1).
2 August 2019
Database:  Updated linescan image upload to check if the local version is newer and/or the image histogram LUT is invalid.  In either case it will delete and reload the entire linescan.   The default upload behaviour is now automatic – to (re-)upload the linescan if it wants to.   Finally, a last-modified date for the linescan is now kept in the TSG dataset.
Floater CLS: The newish 'change one' action now shows a change in the list - the old item is temporarily shown blacklisted (if it’s in view) and the new item is highlighted.   Also, some list actions like select none / all / by preset were not updating the plot.   (They do now.)
Floater FFC: There was a glitch that could influence feature tags in the main Spectrum screen.   (It could basically disable their plotting.)   Fixed.   Also, the auto depth-range-filter adjustment should work better now.
5 August 2019
Domain editor, 'Export' tool:  I fixed up the automatic naming of the output file, and generally renamed the tool to 'Report' rather than 'Export' (as that's what it does).
Hole screen:  This is the first screen to get a plot tweak.   (More to come.)   It gets a simple one - just a 'Tick' field where you can enter an interval for the major plot-Y ticks (usually depth in metres).   Zero means the usual auto handling.   Non-zero, e.g., 100 (metres) causes the plot to have a major tick on every 100 (metres).
7 August 2019
Floater CLS: Highlighting after the 'Change 1' action has been improved.   Both the removed and replacement items are now shown highlighted properly.   Also, the 'FromDomain' selection had a glitch in blacklist handling.
Domain editor: The 'From TSA' initialisation was not taking notice of the blacklist for unmixing-class exclusion.   It does now.
Floater FFC:  The control panel was not handling a featex settings change properly.   (In fact it wasn't getting shut down properly because there was something I overlooked when I changed it from modal to modeless earlier this year.)   Fixed.
13 August 2019
Floater scratchpad: When importing a speclib and resampling is required, linear interp (instead of L3) is done if the host/speclib channel spacings are similar and other conditions support it.
HyLogger imports: There were still a couple of instances of "tir_tsgtray" naming.   I think they have all been standardised to "tsgtray_tir" now.
[bookmark: _Hlk30587698]Formal update release (build 8.0.5.3).
15 August 2019
Layout copying:  Template:current set remapping wasn't being done.   Fixed.
Plot formatting:  I started work on a plot formatting dialog.   Nothing to see yet.   It will make its first appearance in the Scatter screen, where it will offer more control over ticks, titles, colourbar and physical size (gfx export).
Spectrum screen: Fix to a glitch reported by Alan.   Given a dataset pair, the current reference-library-overlay selection was being shared between the datasets.
Licence_from_affiliate doc updated and renamed slightly.
16 August 2019
SDS import: In-house, hacky support for importing prototype MIR spectra from one of the emerging HyLogger-4 spectrometers.   First attempt.
28 August 2019
Import: Significant reworking of the import code to support the import of more than two (primary + associated) datastreams.   This was done to support the evaluation of emerging HyLogger-4 test datastreams.
Hole screen: Fix to minor glitch in width subsetting of an image column.
Build 8.0.5.5.
I added the Google 'Turbo' rainbow LUT as an option for spectrum / numeric scalar colouring.
29 August 2019
Central minerals list:  Updated to version 9.   It has an extra column (display index - not yet used in TSG) and a few new minerals.
Database:  Fixed scalar database upload dependencies bug.
3 September 2019
New NVCL spectra, potentially for the unmixing library.   I updated TSG's central minerals table for the new minerals.   The new spectra will be available as an extension library for the time being.
Sorting:  I tidied up some loose ends.   Domained unmixing wasn't working properly with sorted datasets, and there was a glitch or two with Tray-screen navigation and pic generation.
5 September 2019
Spectral libraries:  I received more validation data for the new NVCL spectra and have entered most of the chemistry into the spectrum names.   Also, custom chemistry (like this) is now hooked up in TSG, and is used in plots and scalar 'expansions'.
jCLST: jCLST is seeded by SWIR and TIR TSA.   The SWIR TSA is set at mix3 while the TIR TSA was at least mix3 with no cap.   I set the TIR TSA seeding to mix3, otherwise it can blow out.   (e.g., mix6 jCLST was impossibly slow.)
Hole screen: Image-column active-width subsetting is now persistent.
11 September 2019
HL4: Further modifications to support some changes to the experimental / prototype arrangements for trialing the HL4 MIR spectrometer.
NVCL extension library: more sample names have chemistry mark-ups (from validation data).
16 September 2019
Extension libraries: I added a mechanism for automatically blacklisting selected host (system) library unmixing classes.
20 September 2019
Unmixing: I'm trying out a CLS pre-filtering stage before TSA (and TIR TSA seeding in jCLST) - using a CLS fitting pass to thin down the active set passed to TSA.   It can speed TSA up drastically at higher mixing levels.   It's something that Mark Berman suggested a few years ago.
I've just been trying it at mix3 for TIR unmixing, so far using MSDP11 as a test dataset.   It makes TSA go about 3 times faster but the results are different - sometimes worse but sometimes better.   I think I know at least some of the reasons.  I've added a step to restore some items at the subgroup level as I've occasionally seen it lose some subgroup items that TSA 'liked'.   Currently: MSDP11 has 54354 samples with valid TIR TSA.   Judging just on fit error (not right or wrong), pre-filtering is giving 3160 samples a fit that's at least 10% better, and 10100 samples with a fit that's at least 10% worse.   (The remaining 41094 samples get the same or similar fit error.)
So I don't know whether or not I should expose this option.   I might, with the advice that it should only be used for TSA at mixture levels of 4 or more (where the speed-up can turn 'impractical' into 'quite fast actually').
25 September 2019
Unmixing: TSA's 'nbest' setting has been increased from 3 to 36 (which is stage 1's /nbestmax'), to increase the number of candidates available at the final selection stage of the algorithm.
Build 8.0.5.8.
26 September 2019
Import:  Recent changes for proto-HL4 messed up the TSG QC triggered import.   Fixed.
Also, Alan found a crashing bug with the Dataset Info dialog.   (Fixed.)
27 September 2019
Import: The SDS import has been modified to support the import of four spectral datastreams.   The current prototype HL4 setup delivers HL3 VSWIR, HL3 TIR, HL4 MIR, HL4 TIR.   It uses the new HL4 detector to deliver the last three of these, and the new HL4 digitiser (plus prototype data flow) to deliver the last two.   (HL3 TIR is done with the new HL4 detector but the old HL3 digitiser / data flow.)
1 October 2019
Settings: 'Custom match scalars' were often triggered for a recalc when just a TSA recalc was in order.
TSA screening:  I tried unscreened vs screened mix5 on Mark's 150-sample TIR dataset.   (This dataset has interpretations from at least three geologists.)   The results are often different but I see no clear winner, judging against the human interpretations that were recorded.
2 October 2019
Unmixing, jCLST: TIR TSA seeding revisited.   I raised the mixture level from 3 to 5 but activated CLS screening for mix 4 and 5.
Floater TSA: 'Replace custom-set result', the newish functionality in multiple-result mode, wasn't working with compatibility across system and user TSA sets and custom sets.   It should, and is now.
8 October 2019
External unmixing, creating a new result set (dialog):  Earlier I had a go at automatically selecting a custom aux TSA source if one was available.   It wasn't working properly but is now.   It streamlines things and gets rid of some of the mystery.
Summary screen, overview plot: For a mineral-level plot, if the analyst has not chosen to sort the bars on size then they get sorted on standard ordering - as advised by Dave Green and Jon Huntington.
11 October 2019
General:  New digital certificate and code signer.
Import: Import-time class scalars aren't forced to lowercase anymore.
Clipboard: If the metafile can't be copied to the clipboard (e.g., because it's too big) then this won't spoil things for other clipboard formats any more.
UI: I've started work on a Windows 'combobox' list replacement.   The standard Windows combobox hasn't been behaving well in some multi-screen environments.
14 October 2019
Depth logging: Depth calculations weren't working properly on single-section trays.   Fixed.
Win32 combobox list: I am beyond the initial stages of beginning to start the actual replacement of this multi-display-hostile control in TSG.   (It's happening now.)
This is build 8.0.5.10.
15 October 2019
Summary screen: Bugfix.   Recently-introduced sorting on standard mineral order spoiled group and element level overview plots.
Summary screen: On-screen combobox lists have all been replaced by new lists.
16 October 2019
UI: The Log and Spectrum screens now have the combobox-replacement list control.
18 October 2019
Downsampler and spatial summary CSV export: The downsampler can now produce a downsampled, expanded + absolute TSA export that is the same as a spatial summary CSV export.   It even works when recovery rate is used (in both).   To make this possible there was a change in the way the downsampler handles a weight scalar: Normally the downsampler normalises each bin according to the contributor count and weight total for the bin.   Now, if the 'ABSOLUTE' option is set for a scalar (or consolidated scalar item like a TSA set) then this normalisation step is skipped.
23 October 2019
UI: Combobox-replacement list control done for the Stack screen;  halfway through the Scatter screen.
Depth-logging:  Fixed a glitch in recovery-rate calculation that was evident in a chips dataset - where the pixel size in mm is relatively big.
31 October 2019
UI: All on-screen Win32 combobox list controls have been replaced by custom list controls that behave better on multi-screen computers.
1 November 2019
Downsampling: template load, basis range handling.   I re-worked this to make it more useful in the 'headless' environment.
Rockmarks editor (both Tray and Log screen): This tool was not doing an automatic sync of edits to the associated dataset (paired-dataset cases).   It is now.
4 November 2019
PLS:  Stupid, annoying little 'copy and paste' bug found in the session save.   Likely responsible for the session-load crashes that sometimes happened.   Fixed.
6 November 2019
Headless mode, copy-processing: I had a restriction where copying TSA settings also required that scalar copying was active.   I don't recall why.   I have removed the restriction.
GUI: Final touch (removed a new crashing bug).
7 November 2019
I added mylar to TSG's built-in mineral list, and a mylar swir extension library is available.
8 November 2019
TSA: CLS screening is automatically enabled for mixture level above 3.   This makes high-mix-level runs feasible (otherwise they're much too slow).
Headless: New task COPYSCLR to copy a scalar from the primary to associated dataset or vice-versa.
This is build 8.0.5.12.
12 November 2019
Scalars: New tool "Edit -> Copy scalar Primary <-> Assoc" added.   (It's an interactive version of the new COPYSCLR headless task.)
Hole screen: 'Dots with no lines' plot option added for scalar columns.
PLS: Maximum #factors increased for cross validation.
18 November 2019
Graphics:  Custom physical sizing (achieving a specified size in mm) implemented for saving graphics to file in raster format.   No custom sizing seems possible for metafiles.   There is no documented route, and 'hacking' the reference dimension info doesn't work.   I’ve tried a few approaches.
NOTE the custom sizing settings are not exposed yet.
26 November 2019
Scatter screen:  Glitch fixed in Y range, to do with a set-scope subscreen that has Y=set weight.
27 November 2019
Tray pictures:  Title text overlapped left & right icons sometimes.   Now limited to 75% of the plot width.
2 December 2019
Graphics:  Custom format tweaks are now coded (first draft) in the central axis-drawing and colourbar routines.   Nothing's exposed yet.   Next will be a custom format dialog, supporting summary subscreens and scatter subscreens (for starters).
3 December 2019
Graphics:  Started work on the custom-format-tweak dialog.   Nothing to see yet.   (Not a pixel.)
Chinese core-logger import:  The linescan raster was not getting finished off properly.
Tray screen:  DPI limit in tray-pic and mosaic-pic generation raised (by a couple of digits!) to allow for the hi-res 'linescan' of the Chinese core logger.
6 December 2019
Plots etc.   I revisited the 'A4' client resizing option in the View menu.   The plot-format-tweak dialog is basically wired and looking for something to do.   Erick has a use case - the Stack screen.   So this will be the first screen to get the dialog's support.   The dialog will be invoked from the main View menu, with its option just above the A4 resizing one.
Plot tweaks: First exposure - stack screen.   Tweaks aren't saved and no serious debugging has been attempted but it's available for early testing in build 8.0.5.13.
11 December 2019
Plot tweaks: First draft support for summary, log, spectrum, stack screens.   Settings aren't persistent yet.   Log screen tweaks are only for "all log columns", not single logs, and have raster sizing and a little X-axis control.
The raster sizing was an adventure in font handling but I think I have something passable.   It is only for saved raster files, not clipboard copies.
12 December 2019
Plot tweaks: Scatter, Tray and Hole screens done too.   Further refinements to font sizing for saved gfx and prints.
13 December 2019
Plot tweaks: Persistence done (.ini-file save / load).
Build 8.0.5.14
That’s probably it for 2019.
13 January 2020
No mistake with the date there – I’ve been on leave.
Scalar sort - modified to preserve original sample order over samples with the same value in the sort scalar.
Layout copying: If the template dataset has a hole-screen column that's named after the template dataset's hole ID then the target dataset's hole-screen column gets named after the target dataset's hole ID.   (Requested workflow feature.)
14 January 2020
Special Dataset Components: Sync to the associated dataset is now done when any scalar is assigned as a 'special scalar'.   (In the past this just happened with depth and finalmask.)
Synchronise Datasets: This call now handles all scalars dealt with in Special Dataset Components (like HoleID, Easting and Northing for example).
16 January 2020
Downsampler:  When a template is used and scalar downsampling to CSV is done, the CSV columns are named and ordered according to what's recorded in the template.   An output column's values will be blank (just a comma in the CSV) should the 'current' dataset's column name have no lexical match to a template column name.
A newly-generated (Jan 2020) template is required for this functionality as the template configuration-file format had to be extended to support it.
This new functionality should deliver reliable CSV column ordering in a production workflow.
Build 8.0.5.15.
22 January 2020
Licence:  I cleaned the licence dialog up a bit, removing irrelevant fields and improving the tooltips.   Then I added a new button 'Switch' and hooked it up.   Users can now switch between two licenses more easily.   (e.g., Say they have their own Base (viewer) licence and sometimes use a shared Premium licence.)   'Switch' deactivates the current licence and prompts to activate another licence.   TSG now remembers two sets of licence ID and password, so once they have done a switch it is easier on future occasions.
This is build 8.0.6.1.   I intend it to be the next formal release.
23 January 2020
TSG help:  I added an 'other TSG documents' page to the help file.   It has summaries and links to documents on the TSG website.
28 January 2020
Build 8.0.6.1 goes out.
31 January 2020
Log screen: The last 3 standard setup options weren't hooked up properly to the menu.   Fixed.   Also the (wrongly invoked) custom result set option could cause a crash.   (Also fixed.)
Resampling:  Minor adjustment to lanczos.
'Elite' aux attach (for custom unmixing): If the aux lib had 'tableindex' tags that went beyond the built-in table (e.g., old TSG, new library) then TSG would crash.   (Fixed.)
6 February 2020
Downsampler, config-file handling: If the config file specified 'no mask' then this was ignored, and if the downsampler had initialised with final_mask selected (as it does if fm is there) then fm would remain selected.
Field-specta, pic import: The 'dup' function (duplicating a pic filename for when 2+spectra share the same pic) had an artificial cap.
Spectral interpolation:  Lanczos tweaked a bit more;  bandpass 'search radius' expanded from 4 to 5 standard widths.
MIR: Andy Green has prepared a stitched USGS library spanning about [200,14500] nm.   It includes 56 minerals that needed to be added to TSG's central list.   I did that, marked up the library's spectrum names, and spun off a [2000,5500]nm MIR subset.   I made quite a few changes to TSG's external library support to get MIR TSA going.   It's very much a first attempt with rudimentary background modelling and no attempt at SWIR-like subclass clustering (which can't be done with this USGS collection).   It's not hopeless though.
Build 8.0.6.2.
11 February 2020
Agilent import:  Sample date (from file's last-modified date) was receiving an unnecessary UCT->Local time conversion.   Fixed.
Central minerals table: A couple of entries (tourmalines) had blank chemistry but non-zero density.   (I went against my own rules.)   Led to hopelessly busy colourbars in summary element plots.   Fixed.
Build 8.0.6.3.
12 February 2020
Assay import: A double-quote in an item of a CSV row was causing TSG to reject the whole row.   For example say a row, in Excel, has a text item: This item includes "double" quotes.   When Excel exports to CSV this becomes: "This item includes ""double"" quotes".   Fixed.
14 February 2020
MIR unmixing: I tried two water princomps derived from Jon's recent Agilent measurements.   I think they improve the MIR background modelling a bit but it's hardly worth mentioning at this point.
Floater: Fixed an occasional crash due to a 'remembered' stats plot settings.   Possible when viewing stats for one dataset, then closing and opening another dataset.
Scalar CSV import:  More attention to the handling of quotation marks.   Excel threw me a bender.   When exporting CSV file it puts string items in quotes and doubles up any embedded quotes, but it doesn't do this when copying a CSV to the clipboard.   TSG now copes with both and I think it's better than it was.   Still, the recommended route is file rather than clipboard from Excel.
TSA TNG: Given the apparent lack of an auto translator I have started a hand translation of Yi Guo's Fortran90 GSS code.   It's going to take a while...
ASD import:  A list of failed files is now created.   A short explanation is given for each one.
18 February 2020
Summary screen: Bugfix.   A check done (dataset pair only) could cause a crash sometimes.   Fixed.
ASD import: TSG now keeps track of any files that failed to import and lists them in a file 00FAILEDIMPORTFILES.txt that it creates alongside the binary files.
Build 8.0.6.4.
27 February 2020
Modules - small change to built-in library formatting.
28 February 2020
Modules:  Modified the TSA json query function to take either an auxcalc handle, or (new) a batchcalc handle where there is only 1 batch method and it is an auxcalc.   Fixed bugs on ubuntu running (Lingbo).   Minor changes for headless download service mode (Lingbo).
3 March 2020
Headless: Changes to allow a combined startup-diag and script log file.
CLS recalc: Some invocations were partial - no redoing of class defs.   (Notably the Domain editor's recalc button.)   Problematic when updating old datasets.   Improved.
Spatial summary:  Sample tracking could come unstuck if the X scalar (normally Depth) was not in sort order, and could even cause a crash (when combined with a linked spectrum-mode floater).   Basic issue fixed and crash blocked (anyway).   Also, the bin-size logic was reworked to be more accommodating to small datasets.
External unmixing libraries (full or extension):  Group names were wrong for the CLS algorithm (but okay for TSA).   Fixed.
Licence:  More robust handling of the headless download service's use of TSG.
Build 8.0.6.5.
4 March 2020
Licensing:  The system started requiring network access to load the local licence file and failed if there was no access.   (TSG went unlicensed and tried to set up a trial Viewer licence.)   Reported, and rolled back to the previous version of the SWK library.
Downsampler, template handling:  The template load would fail if the downsampling method was 'spans from an external file' and there was a space in the external file's filename.
5 March 2020
Modules:  New JSON query options (with item names instead of indices) for TSA results.
5 March 2020
Modules:  Further changes to TSA reporting function.
7 March 2020
General:  Internal 'screen closing' logic improved.   Believe it or not, this was actually causing scat-screen moving-average overlays to fail to show sometimes.
Domain editor:  Logic tightened for 'no domain editing on sorted datasets' and 'no sorting while the domain editor is up'.
Build 8.0.6.6.
8 March 2020
Import:  Agilent import - better handling of files with mixed spectral ranges.   Dynamic import - config dialog doesn't come up on each (drag &) drop anymore - only when a file with a different wavelength range is dropped.
17 March 2020
Special dataset components:  The (new) sync of special scalar changes to the associated dataset wasn't done right and didn't happen - fixed.   The lower-level scalar sync routine was also made a little more robust.
ENVI import:  The ".raw" data-file extension is used for SpecIM sometimes, and TSG wasn't recognising it.
Licence doc: Updated, minor changes.
19 March 2020
Domain editor:  Jon easily crashes TSG with the Domain editor (MIR-'capable' dataset) and I cannot repeat it.   (I've tried a lot.)   I've added some exception handlers to try to narrow down the cause.
Licensing:  Followed up with SWK.   Clarification.   Subtle change in behaviour due to an updated component in the SWK library.   Back with the latest SWL library.   Resulted in minor changes to TSG's startup - should be a bit quicker now.
Build 8.0.6.7.
20 March 2020
Domain editor: The hard-to-repeat RMS-list crashing bug has finally been stomped out.
23 March 2020
Modules - TSA - Modification to the preparation of SWIR background curves, to make them more precisely like the built-in ones.
External library unmixing: as above.
Licence: Mods to headless viewer download licence.
24 March 2020
Modules: Central minerals table updated to TSG's current one.   Elements and densities included.
Field-dataset pic import:  Imported GPS scalars were not being finalised and were not saved persistently.
Floater scratchpad: Fixed that sample deletion bug that used to result in scrambled sample names.
External TSA:  User TSA algorithm settings are now honoured.   (Used to be system settings!)
25 March 2020
TIR unmixing:  I've prepared the next system library: MS9.   The next step is to instate it as the new TIR system library and prepare the remapping indices for previous TIR TSAs, etc.
26 March 2020
I think I have attended to all the old-to-current index remapping stuff for the new TIR TSA library.   I'm about to instate the new library.
…The new library's in but TSG's saved system settings needed some attention.   Maybe almost there now?
27 March 2020
TSA: The new TIR library appears to be ready.
Scatter screen:  New option - copy current sub, which piggybacks off the 'move current sub' dialog.   It's for setting up one sub exactly like another and should provide a good shortcut for preparing some layouts.   Also, some of the scat undo options needed attention.
Minor changes to licence startup function.   Modifications to one of the built-in-library old-to-new index remapping functions, to allow some roll-back to the last TIR library.
30 March 2020
The MS9 TIR library is poised and waiting.   There was an ugly issue if one went from the MS8.2a TSG to the MS9 TSG and back again.   (TSG's system-stored mapping of active TIR minerals got messed up.)   Therefore I have this build.   It will probably be the last build of TSG that includes the MS8.2a library.   It should be able to cope if you install a newer build for a while, then revert.   (System settings not datasets - datasets touched by a newer build will have a higher version stamp.)
Build 8.0.6.8.
2 April 2020
Splash screen - new one from Jon.   (It’s in.)
Tray screen - the default depth-tick interval is now a multiple of 0.25 where feasible.
HyLogger SDS import - under the hood, Eddie-style SWIR teflon and dark noise measures are being calculated.
Pre-release build 8.0.6.9.
It has the MS9 TIR library and the dataset version stamp has been bumped.   Any dataset it creates or modifies cannot be opened by an older TSG.
6 April 2020
Import, Chinese core logger: Updated to take aux files (1 per tray) and generate a dataset that's much like a HyLogger-1 import (without profilometer).   Tray screen and decent tray pictures are available.   Relevant routines were moved from xspimporters.c to xspsdf.c.
Splash screen:  Minor layout mods.
7 April 2020
Import, Chinese core-logger: Image-processing options are now exposed as checkboxes in the Import dialog.
Rockmarks:  Any dataset gets a Rockmarks scalar now (not just HyLogging datasets).   There is a new Rockmarks item called 'URL' and its description is supposed to contain a working URL.   I haven't yet hooked up an action to the URL.   (I will probably make a way to hook up the shell 'open' action.)
8 April 2020
Import, oreXpress:It can now handle .SED files where wavelengths aren't in the first data column.
Goto dialog: There's a new button 'Open URL', to go with the new 'URL' tag type in the Rockmarks scalar.
15 April 2020
SDS import: I implemented the noise-on-dark tests, added thresholds and 'critical' checkbox for them in the diag dialog, added diag codes, and updated the built-in docs.
16 April 2020
Graphics, mouse handling: I added a reset function to the mouse zoom (mouse rectangle) scaling tool.   If you don't actually drag out a rectangle (e.g., you just double-click) then the plot gets reset to the full data range.
24 April 2020
TIR library: I've sorted out the standard-algorithm IDs and NVCL database CSV tables.   I think it's good to go, and I should put out a formal release soon.
GSS unmixing code: I'm still churning through the f90 conversion.
Copy-processing: CLS unmixing scalars were outlawed, even as inputs to other scalars (e.g., class extraction scalars).   Eased up now, but only for CLS scalars based on a common system library, when they are inputs to other scalars.   (The CLS scalars themselves can’t be copy-processed, but scalars derived from them can be if the target dataset already has similar CLS scalars.)
29 April 2020
Unmixing:  I have converted Yi Guo's group subset selection fortran-90 code to C, but it still needs a thorough and careful going-over before I try it out.
Floater navigation:  Navigating the Tray screen from a floater was messed up for sorted datasets.   It took a while but I have it working properly now.   The tray-screen and floater combo behave as if the dataset wasn’t sorted.
1 May 2020
CLS scalar creation: The TSA and jCLST algorithm radio buttons are disabled if one of the built-in libraries is selected.   This is because user TSA / jCLST results on a built-in library ought just be created in the normal way.   It is just confusing to have another way to calculate them (to different scalars).
4 May 2020
Hotkey:  New one for class editors (all four): <ALT><Space>.   Only in Select mode for log and tray editors.   Sets to current class: current selection if appropriate, otherwise current sample.
Tray screen, picture generation: I think the plot format tweaks might actually be working here now.
5 May 2020
Floater scratchpad:  Minor improvements.   List: now has checkboxes;  list colours not unavoidably spoiled by selection status for the overlay plot.   Stack plot: current spectrum now plotted in its own colour, not grey.
Tray screen, pics:  Icons are now scaled up for hi-res plots.
6 May 2020
Floater scratchpad:  I worked more on the lists but simply could not get rid of current-sample highlighting for spectrum and stack mode.   I tried everything that I could think of.   Then I hooked up the Floater's little Previous and Next buttons to the scratchpad.   They're live in spectrum and stack mode, and they move the current item up or down (user request, for organising the scratchpad).
[bookmark: _Hlk41556739]8 May 2020
This is build 8.0.7.1, which goes out.
13 May 2020
Floater prev/next navigation: This got spoiled for the scatter screen, by recent work.   Fixed.
14 May 2020
Database upload:  I improved the warning message about tray pictures.   An analyst had a dataset with most but not all of the tray pictures.   The old warning message suggested that there were no tray pictures at all, and that was confusing.
19 May 2020
Headless mode:  A recent change to combined script / diagnostic log handling spoiled the normal functioning of headless script handling.   Fixed.
Floater CLS mode: When active sets are loaded in 'from domain' mode, blacklist handling is not done.   If an item is on in the domain RMS then it is on in the Floater.
21 May 2020
ENVI import:  Initial support for GeoLOGr datasets.   However the image import does not give well synchronised imagery.
Headless: The CLIMPORT task can now do imports of individual .SDS files to single-tray '_tsgtray' datasets, like the ones that TSG QC produces on the HyLoggers.
28 May 2020
Headless: The recent mod to the CLIMPORT task worked, but this task uses the 'directories' option in the multifile system, and that did not dive down into subdirectories.   Now it does.   It will work through a whole tree of subdirectories unless told not to with the NODIVE option.
Updating old datasets:  Automatically updating unmixing results in the associated dataset on dataset open could crash TSG under certain conditions.   Fixed.   (This was not a new bug;  it had just gone unnoticed for some time.)
Plot format tweaks:  Minor adjustments.
Keyboard accelerators:  <CTRL>C added.   Copy to clipboard.
29 May 2020
Scalars-only datasets: The import wasn't putting the scalars in the usual folders.   The Scatter screen wasn't working.   Log-screen sorting wasn't working.   Fixed.
Windows XP build: (This is just for HyLogger QC.)   It wasn't working although I compiled it in the usual way.   bcrypt.dll missing (not on XP).   It last worked in the January release.   It looks like bcrypt.dll is used in SSL.   For the XP build I knocked out TSG's proxy-checking call and reverted to the previous PlusNative library, 5.19.2.0.   It works again.
2 June 2020
ENVI import:  The GeoLOGR option has been disabled for the time being.   It will return if the image sync can be improved.
General:  The Help menu includes a link to the 'what's new' notes for the TSG version concerned.
This is build 8.0.7.4, which goes out formally as an update.
10 June 2020
Hotkey: <CTRL>C (copy to clipboard) changed to <ALT>C to avoid conflicts with standard Windows <CTRL>C.
26 June 2020
Woot!
This is a major update but there's little to see.   A great deal of the code has been reworked to support more than one associated dataset, in anticipation of the upcoming HyLogger-4's three (VSWIR+TIR+MIR) datasets.
Stack screen: Combo stack glitch fixed - messed up when switching from combo to 'a different dataset' - e.g., when going into the combo from VSWIR and going out of the combo to TIR.   Also, new combo option assoc1+assoc2 offered when there are 3 datasets.
This is pre-release build 8.1.0.1.
30 June 2020
Some parts of TSG only supported 2 associated datasets.   I think it's now 3 all the way.
Build 8.1.0.2.
3 July 2020
Small updates and fixes.   First bash at debugging the gss f90->c code conversion.
6 July 2020
TIR unmixing library: Most pyroxenes have now been blacklisted and deselected by default, according to advice from Steve Barnes.   (Initiated by Jon.)
9 July 2020
"Refresh the screen" (toolbar button) operation made more thorough.
Default layout - floaters are once again assigned to different datasets as far as possible.
[bookmark: _GoBack]This is probably my (PM) last check-in, and my last build of pre-release 8.1.0.3.
